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PREFACE

As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.

Contact your EMC representative if a product does not function properly or does not 
function as described in this document.

Note: This document was accurate at publication time. New versions of this document 
might be released on the EMC Online Support website. Check the EMC Online Support 
website to ensure that you are using the latest version of this document.

Purpose
This document describes how to configure and use EMC PowerPath.

Audience
This manual is part of the PowerPath documentation set. It is intended for use by storage 
administrators and other information system professionals responsible for installing, 
using, and maintaining PowerPath software.

Readers of this manual are expected to be familiar with the host operating system, storage 
system management, and the applications used with PowerPath software.

Related documentation
Here is the complete set of PowerPath documentation. All manuals are available on the  
EMC Online Support website:

◆ EMC PowerPath Family Product Guide

◆ EMC PowerPath Family CLI and System Messages Reference Guide

◆ EMC PowerPath and PowerPath/VE Family for Microsoft Windows Release Notes

◆ EMC PowerPath Encryption with RSA User Guide

◆ EMC PowerPath Migration Enabler User Guide

◆ EMC PowerPath Management Pack for Microsoft Operations Manager User Guide

If your environment includes EMC Symmetrix storage systems, refer also to the EMC host 
connectivity guides, which are available on the EMC Online Support website

https://support.emc.com

If your environment includes EMC VNX and CLARiiON storage systems, refer also to the 
following manuals:

◆ EMC host connectivity guides

◆ VNX Storage-System Support website (www.EMC.com/vnxsupport)

◆ CLARiiON Storage-System Support website (www.EMC.com/clariionsupport)
EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide 9
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Preface
Revision history
The following table presents the revision history of this document.

Conventions used in this document
EMC uses the following conventions for special notices:

CAUTION, used with the safety alert symbol, indicates a hazardous situation which, if not 
avoided, could result in minor or moderate injury. 

NOTICE is used to address practices not related to personal injury.

Note: A note presents information that is important, but not hazard-related.

IMPORTANT

An important notice contains information essential to software or hardware operation.

Table 1  Revision history 

Revision Date Description

04 January 21, 2014 Release of PowerPath for Windows 5.7 SP2.
• Support for EMC XtremIO firmware Version 2.2 and later.
• Native LAM support for NetApp storage arrays FAS2240.
• Support for enabling or disabling the Automatic 

Host-Array Registration feature.

03 October 18, 2013 Updated the section “PowerPath uninstallation 
troubleshooting” on page 51 for OPT 427143.

02 June 28, 2013 Added a new MSCS cluster functionality beginning with 
PowerPath 5.7 SP1 for Windows.

01 February 22, 2013 First release of the EMC PowerPath for Windows Version 5.7.
10 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide



Preface
Typographical conventions

EMC uses the following type style conventions in this document:

Where to get help
EMC support, product, and licensing information can be obtained as follows:

Product information — For documentation, release notes, software updates, or 
information about EMC products, licensing, and service, go to the EMC Online Support 
website (registration required) at:

https://support.emc.com

Technical support — For technical support, go to EMC Online Support and select Service 
Center. On the Support page, you will see several options, including one to create a 
service request. Note that to open a service request, you must have a valid support 
agreement. Contact your EMC sales representative for details about obtaining a valid 
support agreement or with questions about  your account.

Normal Used in running (nonprocedural) text for:
• Names of interface elements, such as names of windows, dialog boxes, 

buttons, fields, and menus
• Names of resources, attributes, pools, Boolean expressions, buttons, 

DQL statements, keywords, clauses, environment variables, functions, 
and utilities

• URLs, pathnames, filenames, directory names, computer names, links, 
groups, service keys, file systems, and notifications

Bold Used in running (nonprocedural) text for names of commands, daemons, 
options, programs, processes, services, applications, utilities, kernels, 
notifications, system calls, and man pages

Used in procedures for:
• Names of interface elements, such as names of windows, dialog boxes, 

buttons, fields, and menus
• What the user specifically selects, clicks, presses, or types

Italic Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis, for example, a new term
• Variables

Courier Used for:
• System output, such as an error message or script
• URLs, complete paths, filenames, prompts, and syntax when shown 

outside of running text

Courier bold Used for specific user input, such as commands

Courier italic Used in procedures for:
• Variables on the command line
• User input variables 

< > Angle brackets enclose parameter or variable values supplied by the user 

[ ] Square brackets enclose optional values

| Vertical bar indicates alternate selections — the bar means “or”

{ } Braces enclose content that the user must specify, such as x or y or z

... Ellipses indicate nonessential information omitted from the example
EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide 11
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Preface
Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:

techpubcomments@emc.com
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Installing PowerPath
Before you install
The sequence of steps to configure a storage system and install EMC® PowerPath® or 
PowerPath/VE for Windows Hyper-V on a host depends on the storage system you use.

Note: Throughout this document, all references to PowerPath refer to PowerPath and 
PowerPath/VE for Windows Hyper-V, unless otherwise noted. PowerPath/VE for Windows 
Hyper-V provides the same multipathing functionality as PowerPath for Windows in 
nonvirtual environments, and it supports Migration Enabler and PowerPath Encryption 
with RSA.

EMC Symmetrix storage systems

Install PowerPath after you set up the EMC Symmetrix® storage system and verify that it is 
working properly.

EMC VNX and CLARiiON storage systems

PowerPath installation is an integral part of an EMC VNX™ Operating Environment (OE) 
and CLARiiON® setup and configuration procedure.

For information on when to install PowerPath on a host attached to a VNX or CLARiiON 
storage system, refer to the:

◆ VNX Storage-System Support website (www.emc.com/vnxsupport)

◆ CLARiiON Storage-System Support website (www.emc.com/clariionsupport). From the 
home page, select your storage system type, then use the Attach server link (CX4 
systems) or the Install link (all other systems) to generate step-by-step instructions.

CLARiiON AX-series installation, planning, and troubleshooting documents are located on 
the AX-series support website. For information on accessing the site, refer to the support 
documentation that shipped with your storage system. Refer to these documents for 
prescribed installation information only when AX-series storage systems are used.

XtremIO storage arrays

This section describes the support for EMC® XtremIO™ storage arrays introduced 
beginning with PowerPath for Windows 5.7 SP2.

PowerPath Version 5.7 SP1 is the last version for Windows to include qualified support for 
XtremIO Version 1.05 through generic LAM. PowerPath Version 5.7 SP2 and above only 
supports XtremIO Version 2.2 and later.

If you are upgrading from PowerPath Version 5.7 SP1 to PowerPath Version 5.7 SP2 
through the GUI method, and if generic XtremIO Version 1.05 support is installed as part 
of the 5.7 SP1 package, PowerPath installer provides an option to either continue with the 
installation or abort the installation. If you are performing a silent upgrade through the CLI 
method, you need to pass the XTREMIO_NATIVE_ONLY=1 command line switch to the 
installer to continue with the installation. The "CLI parameters" on page 25 provides the 
required information.

If you continue with the installation, XtremIO Version 1.05 devices will not be managed by 
PowerPath Version 5.7 SP2.
14 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide
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NetApp storage arrays

This section describes the support for NetApp storage array introduced in PowerPath for 
Windows 5.7 SP2.

PowerPath reports NetApp ID in powermt output and in user interface only if the Report 
SCSI Name String Inquiry Descriptor setting is enabled for the initiator group through 
which host is connected to LUNs.

The setting is disabled by default for Windows-based initiator groups, and enabled by 
default for all the other operating system types. Use the following NetApp commands to 
check the current value of the setting:

igroup show -v igroup_name

For example, 

system1> igroup show -v <initiator group name>
<Initiator group name> (FCP):
OS Type: windows
Member: 10:00:00:00:c9:ac:58:ec (logged in on: vtic)
Member: 10:00:00:00:c9:ac:58:ed (logged in on: vtic, 1b)
UUID: 4e4eb665-fff8-11e2-98b7-123478563412
ALUA: Yes
Report SCSI Name in Inquiry Descriptor: Yes

Use the following command to enable report_scsi_name

igroup set igroup_name report_scsi_name yes

For a NetApp HA pair, the following property settings must be set for an initiator group 
before installing PowerPath:

◆ The report_scsi_name property must be enabled (set to yes) for both controllers of the 
pair.

◆ The ALUA property, set using the igroup command must be the same for two 
controllers of the pair, that is, it should either be yes or no for both the controllers.

For example,

igroup set  <ig name> alua yes

OR 

igroup set  <ig name> alua no

Obtain up-to-date information

Check the EMC Online Support website for current information:

❑ PowerPath documentation — EMC updates PowerPath documentation when it 
releases new features with a service pack or when documentation errors are reported. 
To obtain updated PowerPath documentation on EMC Online Support, select Support 
by Product > Documentation.
Before you install 15
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❑ Service packs and upgrades — You can download PowerPath service pack software 
from EMC Online Support. Determine which service packs (if any) to install after 
PowerPath, and whether those service packs have any additional installation 
prerequisites. To obtain service packs on EMC Online Support, select Downloads.

Choose a convenient time

Installing PowerPath requires that you reboot the host. Plan to install or upgrade 
PowerPath when a reboot will cause minimal disruption to your site.

Activate your license 

Effective February 15, 2011, instead of the physical Right To Use (RTU), the default 
delivery method for PowerPath licenses is electronic. An electronic License Authorization 
Code (LAC) is sent by email in order to redeem the license key on the Powerlink Licensing 
portal. This does not affect upgrades because PowerPath retains existing license 
information.

Physical RTU cards are still available as an option. EMC Global Support, at 1-800-svc4emc 
or 1-800-782-4362, can provide more information. 

PowerPath/VE for Windows Hyper-V and PowerPath for Windows require separate 
licenses. However, the licensing process for PowerPath/VE for Windows Hyper-V is the 
same as the licensing process for PowerPath for Windows.

The licensing process for both PowerPath/VE for Windows Hyper-V and for PowerPath for 
Windows is described in the EMC PowerPath Family Electronic License Ordering Process 
Technical Notes, available on EMC Online Support.

Take note of the following regarding licenses:

◆ In nonvirtual environments, installing PowerPath on a host connected exclusively to a 
CLARiiON AX-series array does not require a license. PowerPath provides full support, 
with or without a PowerPath license, when the host is connected exclusively to a 
CLARiiON AX-series array.

◆ If you are upgrading from an earlier version of PowerPath, you do not need to 
reregister. PowerPath will use your old key.

◆ PowerPath Migration Enabler does not require a separate product license. The 
PowerPath Multipathing license includes Migration Enabler functionality for all 
technology types (Host Copy, Open Replicator, TimeFinder/Clone, Encapsulation).

◆ Separate license keys are required to enable PowerPath Encryption with RSA® and 
PowerPath/VE for Windows Hyper-V. The PowerPath Encryption with RSA® license 
supports Host Copy data migration to or from encrypted devices without the need to 
install the PowerPath multipathing license. The PowerPath multipathing license is 
required when migrating with only plaintext devices (no encrypted devices as source 
or target).

◆ Type the registration number exactly as it appears on the card or letter. To reduce 
common typographical errors, the License Key field accepts either uppercase or 
lowercase letters, and certain numbers and letters are interchangeable. Specifically, 
an entry of the alphabetic letters O, I, S, and B is equivalent to an entry of the 
numbers, 0, 1, 5, and 8.
16 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide
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If you have additional questions about entering licenses, consult the online help file by 
pressing F1 from the EMC Licensing Tool. You must have Internet Explorer 5.0 or later to 
view these files. If you do not have this browser installed, you may still view the help file, 
EmcLicTool.chm, directly from the \help folder on the PowerPath installation CD.

Prepare the host and storage system

Prepare the host and storage system:

❑ Go to EMC Online Support and verify your environment meets the requirements found 
in the EMC PowerPath and PowerPath/VE Family for Windows Release Notes and the 
E-Lab™ Interoperability Navigator by running the PowerPath Configuration Checker 
(PPCC). For PPCC installation information, the EMC PowerPath Configuration Checker 
User Guide, available on EMC Online Support, provides additional information.

❑ The EMC PowerPath and PowerPath/VE Family for Windows Release Notes includes 
the qualified Microsoft MPIO framework versions. For Windows Server 2003:

• If the required MPIO framework is not installed on the host, the PowerPath installer 
installs MPIO during PowerPath installation. The PowerPath installer prompts you if 
an earlier or later MPIO version is present on the host.

• If an unsupported version of the MPIO framework is installed on the host, the 
PowerPath installer prompts you to upgrade to the supported version. If you do not 
upgrade, the PowerPath installation aborts.

• If a version of MPIO framework later than the supported version is installed, 
PowerPath provides the option to abort the installation.

Note: MPIO technologies and functionality are unique to each operating system. 
Refer to the documentation provided by your operating system manufacturer for 
specific information.

❑ Before installing PowerPath 5.7.x on a Windows Server 2003 operating system, ensure 
that you install Windows Server 2003 SP2 Microsoft STORPort hotfix Q957910.

• Refer to the “Support Summary” section of the EMC PowerPath and PowerPath/VE 
Family for Windows Release Notes for a list of all Microsoft Hotfixes that are 
required to be installed, depending on your Windows Operating System.

❑ Configure HBA drivers. Ensure that you follow the HBA driver configuration guidelines 
outlined in the E-Lab Interoperability Navigator and the HBA vendor documentation. 
The use of improper settings can cause erratic failover behavior, such as greatly 
increased I/O delays.

❑ For hosts connected to storage arrays through a Fibre Channel switch (that is, a fabric), 
configure the HBAs by using persistent binding for SCSI target IDs.

❑ For first-time installations, remove any version of EMC Navisphere® Application 
Transparent Failover (ATF) installed on the host.

The procedure for migrating from ATF or CLARiiON Driver Extension (CDE) to 
PowerPath is not straightforward. Contact EMC Professional Services for assistance 
on performing the migration. If you perform the migration yourself, you risk the loss 
of data.
Before you install 17
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Booting from a storage array device

The following documents provide instructions for configuring a storage array device as the 
boot device:

◆ EMC Fibre Channel with Emulex Host Bus Adapters in the Windows Environment, 
available on the Emulex website.

◆ EMC Fibre Channel and iSCSI with QLogic Host Bus Adapters in the Windows 
Environment, available on the QLogic website.

Preparing a cluster environment

Chapter 5, "PowerPath in an MSCS Cluster," provides information on installing PowerPath 
in a new or existing cluster.

Installing PowerPath before configuring the network

EMC recommends installing PowerPath after configuring the network.

PowerPath uses the network MAC address to establish a unique identifier for cluster 
reservations. If PowerPath is installed before any network connections are configured then 
PowerPath is unable to establish the unique host identifier.

To install PowerPath before configuring the network:

1. Install PowerPath.

2. Configure the network.

3. Run the emcphostid utility located in the <installdir>\EMC\PowerPath directory. The 
EMC PowerPath Family CLI and System Messages Reference Guide provides more 
information on the emcphostid utility.

4. Restart the host.

Installing in virtual environments

The procedure to install PowerPath in virtual environments is the same as the procedure to 
install in physical environments. You can follow the GUI or the CLI installation procedure 
described in this document.

EMC supports iSCSI connections directly attached to EMC storage using the Microsoft 
Initiator in a child partition. In this configuration PowerPath is supported in a child 
partition to manage multiple iSCSI paths. However, pass-through disks are not supported 
when running EMC PowerPath. For more information on the supported virtual 
environments, refer to the EMC PowerPath and PowerPath/VE Family for Windows Release 
Notes and the E-Lab Interoperability Navigator.

Coexistence with third-party path management software

PowerPath can coexist with MPIO-based third-party path management software such as:

◆ Hitachi Dynamic Link Manager (HDLM)

◆ IBM Subsystem Device Driver (SDD)
18 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide
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◆ HP StorageWorks Secure Path

◆ HP StorageWorks AutoPath XP Virtual Array

◆ Microsoft MPIO (native multipathing)

PowerPath cannot co-manage devices with third-party path management software.

When PowerPath coexists with other multipathing software, the HBA cannot be shared 
between the two.

Before you upgrade or apply a service pack
Before upgrading PowerPath or installing a service pack:

1. Go to EMC Online Support and do the following:

a. Check for the most current information. EMC updates release notes periodically 
and posts them on EMC Online Support.

b. Download the latest version of EMC Reports, available on EMC Online Support, and 
then run the PowerPath Configuration Checker (PPCC).

c. Download the PowerPath software on EMC Online Support at Downloads and save 
it to your local directory.

2. Save the current PowerPath configuration.

• Run the powermt save command to ensure that you have saved the latest 
PowerPath configuration information.

or

• In PowerPath Administrator, right-click the root node and select All Tasks > Save 
Config as. Then specify a file name and click Save.

3. Stop powermt display if it is running.

4. Uninstall any PowerPath hot fixes on the host. Use Add/Remove Programs or Programs 
and Features to verify if hot fixes are installed.

5. If upgrading, review the information in "Supported upgrades" on page 28.

6. Install PowerPath.

7. If installing a service pack or patch, verify the configuration is correct and then save it. 
This ensures the configuration file is updated to the current format.

Note: PowerPath stores configuration information in a file that may be loaded at boot 
time. When using the PowerPath Administrator, the configuration file can be saved 
only under the default filename. After a service pack is applied, the format of the 
configuration file may change so it is no longer backward compatible.

Installation procedures
You can install PowerPath for Windows with the default GUI method or through the CLI. 
Refer to one of the following procedures to install PowerPath.
Before you upgrade or apply a service pack 19



Installing PowerPath
Note: You must have administrative rights to install PowerPath.

◆ "Interactive GUI installation (default method)" on page 20

◆ "CLI installation" on page 23

PowerPath installation creates installation logs by default in:

◆ %ProgramData%\EMC\PowerPath\logs (Windows Server 2008 and later)

◆ %ALLUSERSPROFILE%\Application Data\EMC\PowerPath\logs (Windows Server 
2003).

Interactive GUI installation (default method)

To install PowerPath with the default interactive prompts:

1. If the PowerPath executable file is saved on your local system, go to Step 2. To install 
from the software CD:

a. Load the CD. If autoplay is enabled, your browser launches the Getting Started 
page. If autoplay is not enabled, go to Step 2.

b. Click the appropriate link for your operating system and then select Run this 
program from its current location.

c. Click OK and proceed to Step 3. Continue to Step 2 if autoplay is not enabled.

2. Double-click the PowerPath executable file, or click Start and select Run.

In the Run window, browse to or enter the name of the PowerPath installation 
program: <drive>:\<PowerPath_pkg_name>

3.  Select the language for this installation from the list and click Next. 

Localized versions of the PowerPath installer are available in Brazilian Portuguese, 
Latin American Spanish, French, German, Italian, Japanese, Korean, and simplified 
Chinese.

4. If you are upgrading from PowerPath Version 5.7 SP1 to PowerPath Version 5.7 SP2 
through the interactive GUI method, and if generic XtremIO Version 1.05 support is 
installed as part of the 5.7 SP1 package, a deprecation dialog box appears with an 
option to either continue or abort the installation process. Click Yes to continue the 
installation process.

Note: If you continue with the installation, XtremIO Version 1.05 devices will not be 
managed by PowerPath Version 5.7 SP2.

5. In the setup wizard welcome window, click Next.

6. In the Custom Setup dialog box, select the features for installation. By default, 
Multipathing, Migration Enabler, Management Component, and support for EMC 
storage arrays are selected. Clear unwanted default features or select additional 
features (such as Encryption with RSA or third-party storage arrays such as NetApp) 
and then click Next.
20 EMC PowerPath and PowerPath/VE for Windows Installation and Administration Guide



Installing PowerPath
Note: If you are upgrading from PowerPath Version 5.7.x to PowerPath Version 5.7 
SP2, XtremIO (EMC storage array) is selected for installation by default. NetApp 
(third-party storage array) is not selected for installation by default; however, you can 
install it by selecting it either from the Custom Setup dialog box or through the 
command line interface. The “Add features through the CLI” section provides the 
required information for adding features through command line interface.

• To select or clear features, click the arrow and select the appropriate option from 
the drop-down menu:

– Will be installed on local hard drive

– Entire feature will be installed on local hard drive

– Entire feature will be unavailable

• Click Disk Usage to view the required and available space needed to install 
selected features.

7. Click Next.

a. If you are upgrading from PowerPath version 5.7.x to PowerPath version 5.7 SP2, 
click Update on the Install Update dialog box to directly install PowerPath version 
5.7 SP2 installation package.

8. On Windows Server 2003, if you are installing PowerPath in a cluster environment and 
selected Migration Enabler as one of the feature to be installed, the Migrate in an 
MSCS cluster environment dialog box appears.

a. Select the Configure all cluster groups on the current node check box to add 
PowerPath Migration Enabler cluster resources for all the cluster groups owned by 
the current node. This will automatically configure PowerPath Migration Enabler 
cluster resources in an MSCS environment. Cluster groups owned by other nodes 
will not be affected.

b. Clear the Configure all cluster groups on the current node check box if you do not 
want Migration Enabler cluster resources to be configured.

If you do not configure PowerPath Migration Enabler cluster resources during installation, 
you can still configure them later using the powermigcl command through CLI. The EMC 
PowerPath Family CLI and System Messages Reference Guide provides additional 
information on the powermigcl command, its syntax, and the associated arguments.

9. In the Ready to Install dialog box, click Install.

a. If PowerPath detects that files that need to be updated are currently in use, select 
one of the following options:

– Automatically close and attempt to restart applications.

– Do not close applications (A reboot will be required.)

If PowerPath does not detect files currently in use, proceed to Step c.

b. Click OK.

c. On the Windows Security dialog box, click Install to install the device software.
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Optionally, select Always trust software from <device vendor>.

d. If there is no license in the registry, the EMC Licensing Tool appears.

When prompted by the EMC Licensing Tool, type your 24-digit registration number 
in the License Key field, and then click Add. 

Note: 
— PowerPath for Windows and PowerPath/VE for Windows Hyper-V each require a 
separate license. The licensing procedure is the same for each.
— When upgrading PowerPath, the existing license key is saved and no input is 
required. 
— To enable PowerPath Encryption with RSA or additional array support, enter the 
license keys. Migration Enabler is enabled when you enter a valid multipathing 
license key.

e. Click OK.

10. In the installation Wizard Completed dialog box, if you want to change the 
Management Component default settings, click Launch Management Component 
Configuration Utility. Click Finish.

If you do not launch the Management Component Configuration utility during 
installation, you can configure the Management Component later by going to Start > 
Programs > EMC > Configuration and selecting Management Component Configuration.

If you launched the Management Component Configuration utility, review the following 
parameters. The PowerPath Viewer Installation and Administration Guide provides 
more information.

• Ensure that Enable PowerPath Management Component is selected. It is selected 
by default.

• In the Port Number field, maintain the default and recommended port value of 
9083 or change the port value to a value between 49152 and 65535 if another 
application is already using the default port (9083).

• In the Heartbeat Interval field, maintain the default value of 10 minutes or change 
the heartbeat interval value to a value between 1 and 60. EMC recommends that 
the heartbeat interval be based on the number of hosts being managed.

• Click Disable Single Path Symmetrix GateKeeper Setup Warnings to maintain the 
default setting if you do not want Setup errors to be reported for Symmetrix 
gatekeeper devices that are configured with a single path. Otherwise, clear the 
check box if Symmetrix gatekeeper devices are multi-pathed in your data center.

Note: PowerPath supports both single-path and multi-path configured Symmetrix 
gatekeepers. Consult your network administrator for more information about your 
Symmetrix gatekeeper configuration.

• Click to make PowerPath performance metrics (PowerPath counters) available in 
the Windows Performance monitoring tools.
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11. Click Yes to reboot now or No to reboot later.

12. (optional) If you installed Migration Enabler or Encryption with RSA, and if you are not 
planning to use these features, EMC recommends that you disable these services and 
change the Startup type to disabled.

Note: When Encryption services are enabled, Migration services are automatically 
enabled.

13. When the host restarts, follow the instructions in "After you install or upgrade" on 
page 30.

CLI installation

To install PowerPath using the more advanced command line interface, follow these steps. 
Use spaces to separate multiple properties.

1. Use this command syntax to install PowerPath:

<drive>:\<PowerPath_pkg_name> <install_parameters> /v"<Property>=<Value>"

• For a silent installation, which does not require user input, use this syntax:

Note: Silent installation errors are logged in <logfile>, the location specified in the 
installation command. No error message appears in the PowerPath Administrator 
GUI.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> <Property>=<Value>"

• For an interactive installation, which requires user input, use this syntax:

<drive>:\<PowerPath_pkg_name> /v"/L*v <logfile> <Property>=<Value>"

Where:

– <drive> is the drive letter, for example, C.

– <PowerPath_pkg_name> is the PowerPath package name. For example, 
EMCPower.X64.signed.5.7.SP2.bxxx.exe

– <install_parameters> is one or more parameters described in Table 2 on 
page 25.

– <logfile> creates the log file where the log message will be sent, for example, 
C:\logs\PPsetup.log.

– Ensure the specified directory exists within the specified path.

– <Property>=<Value> is one or more optional properties described under the /v 
parameter in Table 2 on page 25.

Examples: Silent installation

To install all default PowerPath features (Multipathing, Migration Enabler, 
Management Component, and support for EMC storage arrays) using the silent 
installation method and to also set the PowerPath license and disable reboot, enter:
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Note: Silent installations include the /s parameters.

C:\EMCPower.X64.signed.5.7.SP2.bxxx.exe /s /v"/L*v C:\logs\PPsetup.log 
LICENSENUM=0000-0000-0000-0000-0000-0000 NO_REBOOT=1"

To install PowerPath using the silent installation method and to also disable reboot 
and install PowerPath Encryption with RSA, enter:

C:\EMCPower.X64.signed.5.7.SP2.bxxx.exe /s /v"/L*v C:\logs\PPsetup.log NO_REBOOT=1 
ADDLOCAL=RSA"

Example: Interactive installation

To install PowerPath using the interactive CLI method and to set the PowerPath 
license, copy, and install PowerPath files to C:\Test folder, disable reboot, and install 
components to support IBM ESS, Hitachi, and NetApp storage arrays, enter:

C:\EMCPower.X64.signed.5.7.SP2.bxxx.exe /v"/L*v C:\Install_IBM_HDS.log 
LICENSENUM=0000-0000-0000-0000-0000-0000 INSTALLDIR=C:\Test NO_REBOOT=1 
ADDLOCAL=IBM,HDS"

2. After installing PowerPath, restart the host and then follow the instructions in "After 
you install or upgrade" on page 30.

Note: If you are performing a silent upgrade from PowerPath Version 5.7 SP1 to 
PowerPath Version 5.7 SP2, and if generic XtremIO Version 1.05 support is installed as 
part of the 5.7 SP1 package, you need to pass the XTREMIO_NATIVE_ONLY=1 
command line switch to the installer to continue with the installation. The "CLI 
parameters" on page 25" provides the required information.

If you performed a complete install, and you are not planning to use the PowerPath 
Migration Enabler or PowerPath Encryption with RSA features, EMC recommends that 
you disable these services and change the Startup type to disabled.

Note: When Encryption services are enabled, Migration services are automatically 
enabled.
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CLI parameters
Table 2 on page 25 describes command line parameters and options. 

Table 2  CLI parameters and properties  (page 1 of 4)

Parameter Description

/s Suppresses installation dialog boxes. Indicates a quiet installation (no user interaction).
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/v Directs installation to pass the specified 
string (enclosed in quotes) to the 
Microsoft Installer (MSI).
Example:
/v"<Property>=<Value>"
Where:
<Property> and <Value> descriptions 
follow.

Property Value description

LICENSENUM=<number1,
[number2,...]>

Where <number1,[number2, ...]> must be a valid license or no 
license will be saved. Use commas to separate multiple entries.

Note: PowerPath for Windows and PowerPath/VE for Windows 
Hyper-V each require a separate license. The licensing procedure 
is the same for each.

INSTALLDIR=<path> Where <path> is the location to copy and install PowerPath files.
Examples: 
INSTALLDIR=C:\Test 
INSTALLDIR=C:\Program Files\EMC

NO_REBOOT=1 The value 1 specifies that the host will not reboot after PowerPath 
is installed.

Note: EMC recommends NO_REBOOT=1 so that you can manually 
restart at a convenient time.

AUTO_HOST_REGISTRATION=1 The value 1 specifies that the automatic host array registration is 
enabled. By default, it is enabled.

If you want to disable the automatic host array registration, you 
must specify the value 0.

UPGRADE_MPIO=1 The value 1 specifies to upgrade the existing MPIO framework. 
Include this property if an MPIO version earlier than the one 
supported is installed. PowerPath installation aborts if the host 
has a version of the MPIO framework earlier than the supported 
version. Refer to the “Support Summary” section of the EMC 
PowerPath and PowerPath/VE Family for Windows Release Notes 
for supported versions.

XTREMIO_NATIVE_ONLY=1 The value 1 specifies to install support for XtremIO Versions 2.2 
and later for PowerPath Version 5.7 SP2.
This parameter is required in case of silent upgrade, when you are 
upgrading from PowerPath 5.7.x with generic XtremIO support 
installed to PowerPath 5.7 SP2 and later, which only supports 
XtremIO Version 2.2 and later.
Example:
EMCPower.X64.signed.5.7.SP2.bxxx.exe /s /v” 
XTREMIO_NATIVE_ONLY=1 NO_REBOOT=1”

Table 2  CLI parameters and properties  (page 2 of 4)

Parameter Description
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ADDLOCAL=<feature> Where <feature> can be any combination of the following items. 
Use commas to separate multiple entries, for example: 
ADDLOCAL=RSA,IBM
• If you do not pass ADDLOCAL values during command line 

installation, then PowerPath multipathing, Migration Enabler, 
Management Component, and support for EMC storage arrays is 
installed by default. If you pass ADDLOCAL values only the 
features you select are installed with PowerPath multipathing. 
For example, ADDLOCAL=RSA installs PowerPath Encryption 
with RSA and PowerPath multipathing.

• In the case of an upgrade, if you do not pass ADDLOCAL values 
during command line installation, PowerPath installs the 
features based on the previous version configuration. For 
example, if your previous version has Migration Enabler, HPXP, 
and IBM features installed then PowerPath upgrade selects 
these features for installation by default.

• ALL = Complete installation. Installs support for all PowerPath 
features.

• ME = Migration Enabler (selected for installation by default)
• RSA = Encryption with RSA
• HA = Management Component (selected for installation by 

default)
• IBM = IBM ESS and XIV arrays
• CELERRA = EMC Celerra and VNXe arrays (selected for 

installation by default)
• HDS = Hitachi arrays
• HPXP = HP XP Active-Active arrays, and HP EVA arrays with 

firmware VCS 4.0 or later
• INVISTA = EMC Invista and VPLEX arrays (selected for 

installation by default)
• XTREMIO = EMC XtremIO arrays firmware Version 2.2 or later 

(selected for installation by default)
• NETAPP = NetApp arrays (FAS2240)

PX_DELETE_CUSTOM_CONFIGURATION=
DELETE

PX_DELETE_CUSTOM_CONFIGURATION=
KEEP

The PowerPath installer provides an option to either keep or delete 
the existing powermt.custom file through GUI or CLI methods. By 
default, the existing powermt.custom file is preserved.
For example, the CLI method provides the parameter 
EMCPower.X64.signed.5.7.SP2.bxxx.exe /s 
/v"PX_DELETE_CUSTOM_CONFIGURATION=DELETE 
NO_REBOOT=1".

FORCE_DRIVER_UPDATE=1 The value 1 will continue to install PowerPath and ignore the 
device manager check for any pending device installation or 
uninstallation activities.

PPME_CLUSTER_GROUP=Group1,Group2

PPME_CLUSTER_GROUP=NONE

PPME_CLUSTER_GROUP=ALL

GROUP = Configures PowerPath Migration Enabler cluster 
resources for the specified cluster groups. You can use 
comma-separated values for multiple entries.

Note: This CLI parameter is applicable only on Windows Sever 
2003.

NONE = No cluster groups will be configured for any cluster node. 
By default, this value is set.

ALL = Configures PowerPath Migration Enabler cluster resources 
on all available cluster groups on the current node.

Table 2  CLI parameters and properties  (page 3 of 4)

Parameter Description
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Supported upgrades
Before upgrading, ensure your environment meets these requirements :

◆ Do not remove redundant cable connections from the array.

◆ On Windows Server 2012, if you are upgrading to PowerPath 5.7 SP2 from any 
previous version of PowerPath other than PowerPath versions prior to 5.7.x, the 
installation will be aborted with the error message, “PowerPath upgrades are not 
supported. Uninstall your current PowerPath version and try installing PowerPath or 
contact EMC Customer Support for assistance”. Table 3 on page 28 lists the 
supported upgrade paths.

To upgrade from a previous version of PowerPath on Windows Server 2012:

a. Uninstall the current PowerPath version.

b. Reboot the host.

c. Install PowerPath 5.7.x on Windows Server 2012.

◆ "Upgrading Windows operating systems" on page 35 provides information on 
upgrading Windows operating systems that have PowerPath installed.

If you have a version not listed in Table 3 on page 28, uninstall that version of 
PowerPath (for example, PowerPath 2.1.3), reboot, and then perform a fresh 
installation of PowerPath 5.7. 

/L*v <logfile> Directs the Microsoft Installer to write verbose output to the file 
specified with this option. The target directory for the log file must 
exist before starting a silent installation by using the logging 
option (as required by the Windows installer engine).
• On Windows Server 2008 and later MSI logs will be also 

available in: %ProgramData%\EMC\PowerPath\logs.
• On Windows Server 2003 MSI logs are collected automatically 

only when setup is launched using PowerPath bootstrapper, 
and will be available in: %ALLUSERSPROFILE%\Application 
Data\EMC\PowerPath\logs.

Note: These folders may be hidden in Windows Explorer.

Table 2  CLI parameters and properties  (page 4 of 4)

Parameter Description

Table 3  Supported upgrade paths  (page 1 of 2)

Windows version You can upgrade directly from these 
versions

PowerPath iSCSI version

Windows Server 2003, x86-based 
version (minimum of SP2 and later)

5.1.x, 5.2.x, 5.3.x, 5.5.x 1.1a

Windows Server 2003, Itanium-based 
version (minimum of SP2)

5.1.x, 5.2.x, 5.3.x, 5.5.x Not supported

Windows Server 2003, x64-based 
version (minimum of SP2 and later)

5.1.x, 5.2.x, 5.3.x, 5.5.x Not supported

Windows Server 2008 5.1 SP2, 5.2.x, 5.3.x, 5.5.x Not supported
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◆ Windows Server Core 2008 and later — If PowerPath is installed through the GUI on 
the core version, the license key dialog box will not appear. Use the emcpreg utility to 
add the license key before rebooting.

◆ Upgrading from 5.1.x to 5.7.x — If you are upgrading from PowerPath 5.1.x to 5.7.x, 
use either the interactive GUI or the interactive CLI method.

◆ Upgrading PowerPath in a boot-from-SAN environment — You can upgrade PowerPath 
in a boot from SAN environment using the same procedure you would use in other 
environments.

Upgrading PowerPath custom file conversion

When the powermt.custom file is stored in a location other than the default location, the 
custom file will not be converted when upgrading PowerPath. This may cause error 
messages to appear after upgrading to PowerPath and running powermt load. If you 
upgrade PowerPath without converting the powermt.custom file, you must recreate the 
settings in PowerPath 5.7.x

In order for the upgrade to convert the powermt.custom file, perform the following before 
beginning the upgrade:

1. Copy the powermt.custom file to the default 
<PowerPath_Installation_Directory>\PowerPath directory.

2. During the upgrade, when prompted, select to keep the existing custom file.

After the upgrade and reboot, the settings saved in the powermt.custom file will be 
automatically loaded.

Beginning with PowerPath 5.7, the powermt_custom.xml file (which is a new XML powermt 
custom file) is created by default in <PowerPath_Installation_Directory>\PowerPath. 

Note: Without persistent binding, the SCSI ID of a LUN may change, leading to ghost paths 
appearing during a host reboot with a saved custom file configuration. This may cause 
powermt to display misleading information. You may also see dead paths in case these 
paths have different SCSI IDs. In such cases, you will also see more paths per LU than 
what was actually configured in your SAN environment.

Windows Server 2008 Server Core 5.1 SP2, 5.2.x, 5.3.x, 5.5.x Not supported

Windows Server 2008 R2 5.3.x, 5.5.x Not supported

Windows Server 2012 5.7.x Not supported

Windows Server 2012 R2 5.7 SP2 Not supported

a. If you have a valid PowerPath iSCSI 1.1 license key installed, it will be converted to a PowerPath base license, which provides the same 
protection as a PowerPath iSCSI license key.

Table 3  Supported upgrade paths  (page 2 of 2)

Windows version You can upgrade directly from these 
versions

PowerPath iSCSI version
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After you install or upgrade
This section describes post-installation tasks. 

First-time installations

If you are installing PowerPath for the first time on a host:

1. Power on the host. PowerPath is now fully configured, with multiple paths to logical 
devices.

2. If the environment is Fibre Channel, ensure zones are configured appropriately. The 
VNX and CLARiiON storage-system support websites and the host connectivity guides 
provide additional information.

3. If you have not already done so, check EMC Online Support for any service packs and 
install any required service packs.

Verify the configuration

To verify the configuration:

1. Power on the host. PowerPath is fully configured with multiple paths to logical devices 
and (if appropriate) correct zones when you boot.

2. Verify the correctness of your configuration by running the following at the command 
prompt: 

powermt display
powermt display dev=all
powermt display ports

Note: If PowerPath sees no devices, but the devices are seen by the operating system, 
verify that the devices are configured for PowerPath support.

Verifying a patch installation

Once a patch is installed, it is listed as a subentry under the EMC PowerPath entry in 
Add/Remove Programs or Programs and Features:

Using Add/Remove Programs or Programs and Features verify that the PowerPath patch 
appears in the list of updated programs:

◆ Click Show updates in Add/Remove Programs.

◆ Click View installed updates in Programs and Features.

Upgrading from generic XtremIO to XtremIO version 2.2 and later

PowerPath Version 5.7 SP1 is the last version for Windows to include qualified support for 
XtremIO Version 1.05 through generic LAM. PowerPath Version 5.7 SP2 and above only 
supports XtremIO Version 2.2 and later.
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PowerPath provides support for either XtremIO Version 1.05 (installed as part of the 
PowerPath Version 5.7 SP1 package) or XtremIO Version 2.2 and later (installed as part of 
PowerPath Version 5.7 SP2 package). You can either have XtremIO Version 1.05 or XtremIO 
Version 2.2 and later, but not both.

If you are upgrading from PowerPath Version 5.7 SP1 to PowerPath Version 5.7 SP2, and if 
generic XtremIO Version 1.05 support is installed as part of the 5.7 SP1 package, the 
"XtremIO storage arrays" on page 14 provides the required information.

Configure the PowerPath Management Pack for Microsoft Operations Manager

You can configure the PowerPath management daemon to remotely monitor specific 
PowerPath events. This feature is available in a separate software package available on 
EMC Online Support. The management daemon integrates with Microsoft Operations 
Manager and allows you to retrieve license and version information from remote 
PowerPath hosts. It also can generate alerts when paths or volumes remain dead for a 
configurable time frame. The EMC PowerPath Management Pack for Microsoft Operations 
Manager User Guide provides more information on configuring and using the management 
daemon.

Note: If you plan to enable and configure PowerPath Management Component version 5.7 
(which comes included in the PowerPath 5.7 for Windows package), you must manually 
remove any existing version of the PowerPath Management Component before installing 
or upgrading to PowerPath 5.7.

Adding features to an existing installation
If PowerPath is installed on your host and you want to install additional features, such as 
PowerPath Encryption with RSA or components to support third-party arrays, follow one of 
these procedures: 

◆ "Add features through the GUI" on page 31

◆ "Add features through the CLI" on page 32

Add features through the GUI

To add features to an existing installation using the GUI:

1. Using Add/Remove Programs or Programs and Features select the installed version of 
PowerPath and click Change.

2. In the Setup wizard welcome window, click Next.

3. Select Modify and click Next.

4. Select the feature you want to install from the drop-down menu.

Note: 
—A selected feature displays a hard drive icon next to it. A red X indicates the feature 
is not selected.
—The icon next to each feature name indicates the feature’s install state. Click Help in 
the Custom Setup dialog box for more information about the icons.
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5. Select the option to install the feature on the local hard drive and click Next.

6. Click Install.

7. Click Finish.

8. Click Yes to reboot now or No to reboot later.

Note: If the User Account Control (UAC) is configured in the Admin Approval mode, 
running the PowerPath setup program to change, repair, or to uninstall PowerPath 5.7 
SP2 using Add/Remove Programs or Programs and Features through the control panel 
results in multiple elevation prompts.

Note: If you are installing Migration Enabler, Encryption with RSA, or Management 
Component then a reboot is not required. However, installing these features with any 
other feature requires a reboot.

Add features through the CLI

To add features to an existing installation using the CLI method, use this command syntax:

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> LICENSENUM=<license_key> 
NO_REBOOT=1 ADDLOCAL=<feature>"

For example, to install PowerPath Encryption with RSA and Invista type the following on 
single line:

C:\EMCPower.X64.signed.5.7.SP2.bxxx.exe /s /v"/L*v C:\logs\PPsetup.log 
LICENSENUM=0000-0000-0000-0000-0000-0000 NO_REBOOT=1 ADDLOCAL=RSA,INVISTA"

When the NO_REBOOT=1 parameter is used, reboot manually after installation.

Note: If you are installing Migration Enabler, Encryption with RSA, or Management 
Component then a reboot is not required. However, installing these features with any 
other feature requires a reboot.

Table 2 on page 25 describes the parameters and options.

Repairing PowerPath installation 
After installing PowerPath, if any of the PowerPath functionality is broken, you can repair 
the installation to resolve those issues.

The repair re-installs PowerPath and modifies only those components of the application 
that are missing or broken. It also re-installs all PowerPath drivers.

Note: Repairing PowerPath requires that you reboot the host.

Follow one of these procedures to repair PowerPath:

◆ "Repair PowerPath installation through the GUI" on page 33

◆ "Repair PowerPath installation through the CLI" on page 33
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Repair PowerPath installation through the GUI

To repair PowerPath installation through the GUI:

1. Using Add/Remove Programs or Programs and Features, select the installed version of 
PowerPath and click Repair.

OR

2. Using Add/Remove Programs or Programs and Features, select the installed version of 
PowerPath and click Change.

a. In the Setup wizard welcome window, click Next.

b. Select Repair and click Next.

c. Click Repair.

d. Click Finish. 

3. Click Yes to reboot now or No to reboot later.

Note: If the User Account Control (UAC) is configured in the Admin Approval mode, 
running the PowerPath setup program to change, repair, or to uninstall PowerPath 5.7 
SP2 using Add/Remove Programs or Programs and Features through the control panel 
results in multiple elevation prompts.

Repair PowerPath installation through the CLI

To repair PowerPath installation using the CLI method, use this command syntax:

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> REINSTALL=ALL" 

For example:

C:\EMCPower.X64.signed.5.7.SP2.bxxx.exe /s /v"/L*v C:\logs\PPrepair.log 
REINSTALL=ALL NO_REBOOT=1"

When the NO_REBOOT=1 parameter is used, reboot manually after installation.
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PowerPath installation troubleshooting
Table 4 on page 34 lists PowerPath installation troubleshooting scenarios.

Table 4  Troubleshooting your installation 

Problem Error message Suggested action

While upgrading to PowerPath 5.7 SP2, 
the PowerPath installer may display a 
warning message if it finds that XtremIO 
Version 1.05 support is already installed 
as part of the 5.7 SP1 package.

Setup has detected support for 
EMC XtremIO storage systems 
installed by existing version of 
PowerPath. EMC PowerPath 5.7 
Service Pack 2 only supports 
XtremIO version 2.2 or later. 
Refer to the Release Notes for 
support information. To continue, 
click Yes.

If you are upgrading from PowerPath 5.7 
SP1 to PowerPath 5.7 SP2, and if generic 
XtremIO Version 1.05 support is installed 
as part of the 5.7 SP1 package, refer to 
the "XtremIO storage arrays" on page 14 
for more information.

PowerPath drivers may be present on a 
host where a PowerPath package has 
been uninstalled.

Incompatible files from a 
previous PowerPath version exist 
on the host. PowerPath recommends 
running PPRemoveAll with a reboot 
and then proceed with the 
PowerPath installation process. 
Run PPRemoveAll now?

Perform the following:
1. Choose Yes to run PPRemoveAlla. 

Otherwise, choose No and run the 
PPRemoveAll utilitya manually.

2. Reboot the host.

3. Install PowerPath.

Upgrade of PowerPath may fail because 
PowerPath drivers are missing on the 
host.

PowerPath detected a problem that 
is blocking the upgrade. Contact 
EMC Customer Support for 
assistance.

Perform the following:
1. Run the PPRemoveAll utility to remove 

PowerPath.

2. Reboot the host.

3. Install PowerPath.

Note: If the installation is still blocked, 
contact EMC Customer Support.

Upgrade of a PowerPath driver may fail. The PowerPath upgrade could not 
complete. PowerPath recommends 
running PPRemoveAll with a reboot 
and then proceed with the 
PowerPath installation process. 
Run PPRemoveAll now?

Perform the following:
1. Choose Yes to run PPRemoveAlla. 

Otherwise, choose No and run the 
PPRemoveAll utilitya manually.

2. Reboot the host.

3. Install PowerPath.

Installation of a PowerPath driver may 
fail.

PowerPath encountered a problem 
installing drivers and will roll 
back the installation changes. 
Contact EMC Customer Support for 
assistance.

Contact EMC Customer Support.

One of more PowerPath drivers may 
require a host reboot.

One or more PowerPath drivers 
require a host reboot. Reboot the 
host and then proceed with the 
PowerPath installation process.

Reboot the host and then install 
PowerPath.

One or more PowerPath drivers 
require a host reboot. Reboot the 
host, and retry the repair.

Reboot the host and then try driver repair 
again.

Repair of a PowerPath driver fails. The PowerPath repair operation 
could not complete. Contact EMC 
Customer Support for assistance.

Contact EMC Customer Support.

PowerPath failed to enable MPIO. PowerPath installation failed to 
enable MPIO feature on Windows 
server 2008 or later host.

Contact EMC Customer Support.
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Upgrading Windows operating systems
You can upgrade your Windows operating system to a major release (from Windows Server 
2003 to Windows Server 2008 or Windows Server 2008 R2) or to its service pack.

Note: The EMC E-Lab Interoperability Navigator and the EMC PowerPath and PowerPath/VE 
for Windows Release Notes provide information on the required service packs on different 
operating systems, supported versions of PowerPath, and any other system information 
that may apply to the operating system you plan to install.

Upgrading to Windows Server 2008 and later

When upgrading the operating system in one of the following scenarios:

◆ From Windows Server 2003 (with PowerPath installed) to Windows Server 2008 or 
Windows Server 2008 R2, or Windows Server 2012

◆ From Windows Server 2008 (with PowerPath installed) to Windows Server 2008 R2 or 
Windows Server 2012

◆ From Windows Server 2008 R2 (with PowerPath installed) to Windows Server 2012

The Windows operating system migration agent does not re-install most PowerPath drivers 
during the upgrade. After the upgrade, all PowerPath functionalities are disabled. When 
upgrading in a boot-from-SAN environment, the operating system upgrade may fail and 
the system may not reboot. This issue is also documented in EMC Knowledgebase 
Solution emc221704.

Procedure
To upgrade the Windows operating system:

1. Remove PowerPath.

2. Upgrade the Windows operating system.

3. Install PowerPath.

The EMC PowerPath and PowerPath/VE Family for Windows Release Notes provides 
additional information.

Installing Windows operating system service packs

You do not need to uninstall PowerPath before installing an operating system service pack 
such as Windows 2008 SP1 on a Windows 2008 host.

Unsupported installation changes
This section describes unsupported installation changes.

a. The PPRemoveAll utility removes all PowerPath multipathing entries from the host. Use this option only when you encounter a problem with an 
existing installation or attempt a removal.
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Host reboot after installation changes

Uninstalling an earlier version of PowerPath without rebooting, and then installing a newer 
version may cause a system crash. To avoid this issue, reboot after installing, uninstalling, 
or upgrading PowerPath.

Note: When the system is not rebooted after installing, uninstalling, or upgrading 
PowerPath, the operating system confuses the uninstallation of old drivers with the 
installation of new drivers, causing a system panic.

Downgrading PowerPath

Do not attempt to install an earlier version of PowerPath on hosts currently running a more 
recent version of PowerPath. If you want to run an earlier version of PowerPath, you need 
to downgrade PowerPath.

To downgrade PowerPath:

1. Uninstall the newer version of PowerPath.

2. Restart the host.

3. Install the earlier version of PowerPath.
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Introduction
You must reconfigure PowerPath after making configuration changes that affect 
host-to-storage-system connectivity or logical device identification. 

For example:

◆ Fibre Channel switch zone changes

◆ Adding or removing Fibre Channel switches

◆ Adding or removing HBAs or storage-system ports

◆ Adding or removing logical devices

◆ Redeploying existing logical devices

Note: If you do not reconfigure PowerPath after making configuration changes, many of 
these changes are treated as unintentional, and PowerPath tries to prevent them from 
affecting applications.

Many platform-specific and some PowerPath reconfiguration operations will fail if the 
affected logical devices are in use (either just marked alive or with I/O in progress). This is 
noted in the appropriate places in the procedures that follow.

After any reconfiguration, you must monitor the outcome of individual reconfiguration 
steps and confirm that the resulting changes are as expected, before relying on the new 
configuration. Otherwise, some paths may not be as expected.

Whenever you make any modification to the default settings, such as changing the default 
load-balancing policies, then you must run the powermt save command to ensure that the 
new settings persist across reboot.

Adding new paths to a PowerPath logical device
This procedure adds new paths to a logical device already configured (with at least one 
path) in PowerPath. 

This procedure can be done without interruption to running applications on Microsoft 
hosts.

All operations must succeed for the reconfiguration to be successful. If any step fails, 
resolve that issue before proceeding. Do not use the new configuration until the entire 
procedure completes successfully.

Path limit
Do not configure more than 32 paths per logical device.

Procedure
To add paths to a PowerPath logical device:

1. Run powermt display to confirm the current configuration. 
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2. Run powermt display dev=all to confirm the configuration of the logical devices to 
which new paths will be added. 

3. Ensure that the number of logical devices, hardware paths, and I/O paths are as 
expected. The path state should be alive for known good paths and dead for known 
bad paths. 

If there is a problem, correct it before proceeding.

4. Make physical path additions as required:

a. Map the logical device to additional storage-system ports.

b. Add new HBAs. For details, refer to your vendor documentation.

c. Attach cables.

d. Rezone Fibre Channel switches.

5. If using SAN Manager, Volume Logix, or Access Logix, make new paths available to the 
host using those tools.

6. Scan for hardware changes in the device manager or alternately, reboot. In some 
cases, the operating system may prompt for a reboot after new devices are added.

7. Reconfigure PowerPath.

8. Inspect the new PowerPath configuration:

a. Run powermt display dev=all.

The new paths should be displayed with a state of alive.

b. Run powermt restore to test all paths.

c. Scan operating system error logs to ensure no errors are logged against the new 
paths.

9. Correct any issues detected.

10. Run powermt save to save the new configuration.

Adding new logical devices to the PowerPath configuration
This procedure adds new logical devices (with one or more paths) to be managed by 
PowerPath and applies to managed storage system classes only.

Logical devices can be added without interruption of service, since no existing application 
can be using a logical device that is not yet available.

After successful configuration, new pseudo devices can be used.

All operations must succeed for the reconfiguration to be successful. If any step fails, 
resolve that issue before proceeding. Do not use the new configuration until the entire 
procedure completes successfully.

Procedure
To add logical devices to the PowerPath configuration:
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1. Run powermt display to confirm the current configuration. Ensure that the number of 
logical devices, hardware paths, and I/O paths are as expected. The path state should 
be alive for known good paths and dead for known bad paths.

2. Make logical device and physical path changes as required:

a. Create new logical devices.

b. Map logical devices to one or more storage-system ports.

c. Add new HBAs. For details, your vendor documentation will provide more details.

d. Attach cables.

e. Rezone Fibre Channel switches.

3. If using SAN Manager, Volume Logix, or Access Logix, make new paths available to the 
host using those tools.

4. Scan for hardware changes in the device manager. Alternately, reboot. In some cases, 
the operating system may prompt for a reboot after new devices are added.

5. Reconfigure PowerPath.

6. After adding LUNs to a storage group and scanning the disk via the device 
manager/diskpart scan operation or through a reboot, the powermt display dev=all 
command may return an error count of 1 for the new LUNs. Run the powermt restore 
command to reset the error count to 0.

7. Inspect the new PowerPath configuration:

a. Run powermt display dev=all.

All paths associated with the new logical devices should be displayed with a state 
of alive.

b. Run powermt restore to test all paths to the new logical device.

c. Scan operating system error logs to ensure no errors are logged against the new 
paths and logical device.

8. Correct any issues detected, before saving the PowerPath configuration or using the 
new logical device.

9. Set PowerPath-specific options for the new logical devices, such as load-balancing 
and failover policy, path modes, write throttle enablement, and priority.

10. Reconfigure PowerPath. 

11. Run powermt save to save the new configuration.

12. On the host where EMC ControlCenter is installed, run the command that refreshes the 
ControlCenter database of device information. Refer to the documentation for your 
version of ControlCenter.
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Removing some paths to PowerPath logical devices
This procedure removes some (but not all) paths to logical devices configured in 
PowerPath.

Do not remove the last live path to a logical device unless you plan to remove the logical 
device entirely, as data access will be interrupted. If a PowerPath device is open, 
powermt remove does not remove that device or the last path to that device.

Note: Failure to follow all the steps in this procedure properly can result in data loss and 
errors that affect the operating system.

Procedure
To remove some paths to PowerPath logical devices:

1. Run powermt display dev=all to confirm the configuration of the logical devices from 
which paths will be removed.

2. Check the number of existing paths.

The path state should be alive for known good paths and dead for known bad paths.

3. If there is a problem, correct it before proceeding.

4. Identify the physical paths to be removed or zoned out, and confirm that there are 
other paths to the affected logical devices. (Otherwise, applications using those 
logical devices could experience I/O errors when you proceed.)

5. Run powermt display dev=all to identify the PowerPath HBA number associated with 
the paths to be removed. In complex topologies, there can be multiple paths on an 
HBA.

6. Run powermt set mode=standby to set the mode to standby for all paths to be 
removed. If an HBA is to be removed, specify the HBA (instead of the device) when 
running powermt set mode.

7. Physically disconnect the paths or logically disconnect them by removing them from 
active zones.

As a result of this, the operating system may log some error messages. However, 
PowerPath prevents these errors from affecting applications.

8. Scan for hardware changes in the device manager. Alternately, reboot. In some cases, 
the operating system may prompt for a reboot after new devices are added.

9. Run powermt restore, and confirm that the paths listed as dead are the ones you 
intended to remove.

10. Run powermt remove, specifying both the hba and dev arguments.

If you do not specify the hba argument, all paths to the specified logical device are 
removed.
Removing some paths to PowerPath logical devices 41



Configuring PowerPath
11. Remove HBAs as required and reboot if needed.

12. Inspect the new PowerPath configuration:

a. Run powermt display.

The output should show fewer total paths than before. All paths should have a 
state of optimal.

b. Run powermt display dev=all.

All remaining paths associated with the affected logical devices should be 
displayed with a state of alive.

13. Correct any issues detected before saving the PowerPath configuration or using the 
new logical devices.

14. Run powermt save to save the new configuration.

Cleaning up incorrect path or logical volume removal
1. Run powermt display to identify the removed volume and its paths. In the output 

these should all display as dead.

2. Run powermt check dev =<dev> for device in question.

Removing PowerPath logical devices
This procedure removes logical devices (with all configured paths to those logical devices) 
configured in PowerPath. Logical devices can be removed without interruption of service 
only if no applications are using or configured to use the logical devices you are removing.

The procedure may fail if any application is using a device associated with the path to be 
removed.

Procedure
To remove PowerPath logical devices:

1. Inspect the current PowerPath configuration:

a. Run powermt display to confirm the current configuration. Ensure that the total 
number of logical devices, hardware paths, and I/O paths are as expected.

Since one or more paths may have failed, not all paths may be listed as optimal.

b. Run powermt display dev=all to confirm the configuration of the logical devices 
that will be removed. 

c. Check the number of existing paths. 

The path state should be alive for known good paths and dead for known bad 
paths.

2. If either of the above displays indicates a problem, correct it before proceeding.

3. Identify the logical devices to be removed.

4. Identify the physical paths that also may be removed.
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5. Run powermt display dev=all to identify the PowerPath HBA number associated with 
the paths to be removed. In complex topologies, there can be multiple paths on an 
HBA.

6. Reconfigure all applications that are using the logical devices to be removed, so they 
are no longer configured to use them.

7. Unmount file systems.

8. Remove the volume groups using the appropriate volume manager command.

9. Scan for hardware changes in the device manager. Alternately, reboot.

10. If using SAN Manager, Volume Logix, or Access Logix, remove access to the logical 
devices to be removed, using those tools.

As a result of this step, the operating system may log some error messages. These are 
expected and are harmless.

11. Run powermt remove dev=all. 

12. Run powermt save.

13. Disconnect physical paths or zone out paths with switched fabric zone changes as 
required.

14. Run powermt restore, and confirm that the paths listed as dead are associated with 
the logical devices you intend to remove.

15. Depending on the type of HBA installed, scan for hardware changes in the device 
manager. Alternately, reboot.

In some cases, the operating system may prompt for a reboot after new devices are 
added.

16. Inspect the new PowerPath configuration:

a. Run powermt display.

The output should show fewer total paths than before. All paths should have a 
summary state of optimal.

b. Run powermt display dev=all.

All remaining paths associated with the affected logical devices should be 
displayed with a state of alive.

17. Correct any issues detected above, before saving the PowerPath configuration or using 
the new logical devices.

18. Run powermt save to save the new configuration.

Configuring the Microsoft iSCSI Initiator for PowerPath
To configure the Microsoft iSCSI initiator for PowerPath:

Note: Also refer to the recommended array and hardware guidelines.

1. On Windows 2003, obtain the Microsoft iSCSI initiator installation kit and launch the 
installation program.
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2. Select Microsoft MPIO Multipathing Support for iSCSI and then click Next.

3. Select Enable multi-path while creating sessions on the target and then click OK.

Note: ?????On Windows 2008 and later, the Microsoft iSCSI initiator is available by 
default, for enabling multi-path, start the service and follow step 3 from the procedure 
listed above. 

Adding PowerPath PMI counters to Windows Performance Monitor
Path Management Insight (PMI) capabilities help performance monitoring by 
characterizing I/O patterns and diagnosing I/O problems. 

The PMI counter and timers on the Performance Monitor framework is published by the V2 
Performance Counter provider. The provider which is hosted by the PowerPath 
Management Service, is part of the PowerPath Management Component and is enabled by 
default. 

Each PMI counter and timer is present in the perfmon. Two specific PowerPath PMI 
counters are displayed as part of the Windows Performance Monitoring tools under 
Performance\Performance Tools\Performance Monitor. These independent counters are 
also listed in the Add Counters wizard and display the following information: 

◆ PowerPath Volume PMI Data — contains all counters and timers for Volumes

◆ PowerPath Path PMI Data — contains all counters and timers for Paths

Collection of data does not start until the powermt set perfmon=<On> command is set. 
Setting the perfmon command to On initializes the performance monitoring counter and 
measurements. Apart from powermt set perfmon, there are two more commands that can 
be used to collect insights for enhanced performance information:

◆ powermt display perf dev

◆ powermt display perf bus

The output of these commands provide:

◆ Read, Write, and Total Throughput 

◆ Read, Write and All Average Response Time

◆ Latency Distribution

◆ Retry delta

◆ Error delta

For more information on these CLI commands, see the EMC PowerPath Family 5.7 CLI and 
System Messages Reference Guide.

Note: This is not supported on Windows 2003. 

For more information on adding counters, refer to Microsoft Performance Monitoring 
documentation.
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Before you remove PowerPath
Before you remove PowerPath from the host:

❑ Check EMC Online Support for the most current information. EMC updates release 
notes periodically and posts them on EMC Online Support.

❑ Stop any application actively sending I/O. In addition, close any remaining 
applications and client files to avoid warning messages when rebooting after the 
uninstall.

Note: If you try to uninstall PowerPath when there are active migrations, the message 
"Migration(s) is (are) pending" appears and the uninstallation process aborts. Contact 
EMC Customer Support if you see the message “An internal error has occurred. 
Migrations may be pending.” 

Removing PowerPath software or components

You can remove PowerPath and all related components, or you can remove specific 
features, such as Migration Enabler or PowerPath Encryption. You can also remove specific 
multipathing components you may no longer need, such as components to support 
third-party arrays.

You can use the Windows Add/Remove Programs or Programs and Features tools to 
remove PowerPath, or you can use the more advanced PowerPath command line interface. 
Use one of these methods to uninstall PowerPath software or features.

◆ "Uninstalling PowerPath with Windows OS tools" on page 46

◆ "Uninstalling with the PowerPath command line" on page 48

Note: EMC recommends that you reboot after removing PowerPath.

Uninstalling PowerPath with Windows OS tools
The procedures in this section describe how to uninstall PowerPath software or 
components using Windows operating system tools.

◆ "Complete PowerPath removal" on page 47 removes PowerPath multipathing and 
makes other PowerPath features unavailable for installation changes through the 
Windows GUI. Future installation changes can only be made through the PowerPath 
executable file or the PowerPath CLI once you complete this procedure.

◆ "Feature-specific removal" on page 47 removes specific PowerPath features, such as 
Migration Enabler, PowerPath Encryption, Management Component, or components 
that provide support for third-party arrays.
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Complete PowerPath removal

Use this procedure to completely remove PowerPath.

1. Using Add/Remove Programs or Programs and Features uninstall the installed version 
of PowerPath.

For Windows Server 2008 and later:

• If User Account Control (UAC) is turned on, click Yes on the elevation.

• If you belong to the Administrative group, click Allow in the elevation.

• If you are a standard user, give the administrative credentials to uninstall.

2. When prompted to remove PowerPath, click Yes.

3. When prompted to reboot the host, click No to reboot later. 

Note: You can reboot after disconnecting redundant cables.

4. Complete the steps in "Disconnecting redundant paths to the storage system" on 
page 51.

Feature-specific removal

Use this procedure to remove specific PowerPath features.

Note: You cannot uninstall PowerPath multipathing for EMC arrays using this procedure. 
Only the complete uninstall procedure removes default multipathing components.

1. Using Add/Remove Programs or Programs and Features select the installed version of 
PowerPath and click Change/Remove.

2. In the setup wizard welcome window, click Next.

3. Click Change and then click Next.

4. To select a feature to uninstall (such as, Encryption with RSA), click the drop-down 
arrow beside the feature on the Custom Setup dialog box:

Note: 
—A selected feature displays a hard drive icon next to it. A red X next to it indicates 
features that are not selected.
—The icon next to the feature name indicates the install state of the feature. Click Help 
in the Custom Setup dialog box for more information about the icons.

a. Select Entire feature will be unavailable.

b. Click Next.

5. In the Ready to Modify the program dialog box, click Change.

6. Click Finish.

7. When prompted to reboot the host, click No to reboot later. Feature removal (other 
than the Management Component) needs reboot.
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8. If you removed multipathing support for any storage systems, complete the steps in 
"Disconnecting redundant paths to the storage system" on page 51.

Uninstalling with the PowerPath command line
The command line method allows you to uninstall PowerPath multipathing and/or other 
features, such as Migration Enabler or PowerPath Encryption.

Use this procedure for complete PowerPath removal or for feature-specific removal.

1. Use this command syntax to uninstall PowerPath:

<drive>:\<PowerPath_pkg_name> <uninstall_parameters> /v"<Property>=<Value>"

• For a silent removal, which does not require user input, use this syntax:

Note: Silent uninstallation errors are logged in <logfile>, the location specified in 
the uninstallation command. No error message appears in the PowerPath 
Administrator GUI.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> <Property>=<Value>"

• For an interactive removal, which requires user input, use this syntax:

<drive>:\<PowerPath_pkg_name> /v"/L*v <logfile> <Property>=<Value>"

Where:

– <drive> is the drive letter, for example, C.

– <PowerPath_pkg_name> is the PowerPath package name. For example, 

EMCPower.Net32.signed.5.7.SP2.bxxx.exe
or

EMCPower.X64.signed.5.7.SP2.bxxx.exe

– <uninstall_parameters> is one or more parameters described in Table 5 on 
page 49.

– <logfile> creates the log file where the log message will be sent, for example, 
C:\logs\PPsetup.log.

Note: Make sure the specified directory exists within the specified path.

– <Property>=<Value> is one or more optional properties described under the /v 
parameter in Table 5 on page 49.

Example: Silent removal

The following example of a silent uninstall completely removes PowerPath. It also 
disables reboot.

C:\EMCPower.Net32.signed.5.7.SP2.bxxx.exe /s /v"/L*v C:\logs\PPremove.log NO_REBOOT=1 
PPREMOVE=CLEAN"
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Example: Interactive removal

The following example of an interactive uninstall disables reboot and removes 
components to support HP XP and Hitachi arrays.

C:\EMCPower.Net32.signed.5.7.SP2.bxxx.exe /v"/L*v C:\Uninstall_HPXP_HDS.log NO_REBOOT=1 
PPREMOVE=HPXP,HDS"

The following example of an interactive uninstall removes only PowerPath Encryption 
with RSA:

C:\EMCPower.Net32.signed.5.7.SP2.bxxx.exe /v"/L*v C:\logs\Uninstall_RSA.log NO_REBOOT=1 
PPREMOVE=RSA"

The following example should be used only in case if you encounter a problem with 
normal PowerPath uninstallation (interactive/silent uninstallation).

Note: EMC recommends using the PPREMOVE=CLEAN option as command line 
uninstall option (for complete removal of PowerPath).

The /r parameter replaces PPREMOVE=ALL. By default, a bootstrapper log is created in 
%ProgramData%\EMC\PowerPath\logs. Adding the /L*v <logfile> parameter does not 
create a log file when using the PPRemoveAll utility.

C:\EMCPower.Net32.signed.5.7.SP2.bxxx.exe /r

2. After uninstalling, complete the steps in "Disconnecting redundant paths to the 
storage system" on page 51.

CLI parameters Table 5 on page 49 describes the CLI parameters and properties.

Table 5  CLI parameters and properties  (1 of 2)

Parameter Description

/s Suppresses installation dialog boxes. Indicates a quiet removal (no user interaction).

/v Directs installation to pass the specified string (enclosed in quotes) to the Microsoft Installer (MSI).
Example:
/v"<Property>=<Value>"
Where:
<Property> and <Value> descriptions follow.

Property Value description

NO_REBOOT=1 The value 1 specifies that the host will not reboot after PowerPath is installed.

Note: EMC recommends NO_REBOOT=1 so that you can manually restart at a 
convenient time.
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PPREMOVE=<feature> Specifies the features to uninstall. Use commas to separate multiple entries, 
for example: PPREMOVE=ME,RSA
• CLEAN = Removes PowerPath and all other features, such as Migration 

Enabler and PowerPath Encryption. It also removes driver files and 
corresponding registry entries.

• ME = Migration Enabler
• RSA = Encryption with RSA
• HA = Management Component
• IBM = IBM  ESS and XIV arrays
• CELERRA = EMC Celerra and VNXe arrays
• HDS = Hitachi arrays
• HPXP = HP XP Active-Active arrays, and HP EVA arrays with firmware VCS 

4.0 or later
• INVISTA = EMC Invista and VPLEX devices
• XTREMIO = EMC XtremIO arrays firmware Version 2.2 or later
• NETAPP = NetApp arrays (FAS2240)

FORCE_DRIVER_UPDATE=1 The value 1 will continue to install PowerPath and ignore the device manager 
check for any pending device installation or uninstallation activities.

/L*v <logfile> Directs the Microsoft Installer to write verbose output to the file specified with 
this option. The target directory for the log file must exist before starting a 
silent removal by using the logging option (as required by the Windows 
installer engine). 
• On Windows Server 2008 and later MSI logs will be also available in: 

%ProgramData%\EMC\PowerPath\logs.
• On Windows Server 2003 MSI logs are collected automatically only when 

setup is launched using PowerPath bootstrapper, and will be available in: 
%ALLUSERSPROFILE%\Application Data\EMC\PowerPath\logs

The PPRemoveAll utility does not create a logfile when using the /L*v 
parameter. Instead, a bootstrapper log is created by default in 
%ProgramData%\EMC\PowerPath\logs.

/r
Notice: Contact EMC Customer Support before using /r.

Use this option only when you encounter a problem with either installation or uninstallation of PowerPath.

This invokes the PPRemoveAll utility, which removes all PowerPath multipathing entries from the host. . This /r 
switch replaces PPREMOVE=ALL.

Note: You do not need any of the above parameters with the /r switch.

Table 5  CLI parameters and properties  (2 of 2)

Parameter Description
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PowerPath uninstallation troubleshooting
Table 6 on page 51 lists PowerPath uninstallation troubleshooting scenarios.

Disconnecting redundant paths to the storage system
After uninstalling PowerPath, disconnect redundant paths to the storage system.

Data corruption is possible if multiple paths remain on a system after PowerPath is 
removed. 

To disconnect redundant paths:

1. In the Shut Down Windows dialog box, select Shut Down from the list, and click OK.

2. With the host shut down, disconnect redundant cables from the HBAs to the storage 
system interface ports.

Note: SAN (fabric) configurations may have multiple logical configurations per 
physical connection. Ensure that no redundant zoned paths exist.

3. Restart the host. PowerPath is completely removed from the host.

Table 6  Troubleshooting scenarios 

Problem Message Suggested action

Uninstalling MPIO and PowerPath in a 
boot-from-SAN configuration on a 
Windows 2003 host with no other third 
party DSM installed requires two reboots.

In a boot-from-SAN configuration, 
two host reboots are required to 
uninstall PowerPath and MPIO. To 
uninstall PowerPath and MPIO, 
choose Yes. To uninstall 
PowerPath and leave MPIO 
installed, choose No. To exit, 
choose Cancel.

1. Click Yes to uninstall PowerPath and 
MPIO.

2. Click No to uninstall only PowerPath.

3. Click Cancel to abort uninstallation.

Uninstalling PowerPath in a 
boot-from-SAN configuration on a host 
that has Windows Server 2008 R2 or later 
requires two host reboots.

PowerPath cannot disable some of 
its devices because a page file 
is located in a LUN under 
PowerPath control or host is 
configured to boot from SAN. 
Under these scenarios, two host 
reboots are required to uninstall 
PowerPath. Click OK to proceed, 
or Cancel to exit.

1. Go to Control Panel and select 
Add/Remove Programs.

2. Select PowerPath from the list of 
programs.

3. Click Remove.

4. Reboot the host.

5. Repeat steps 1 through 3. 

6. Reboot the host.

MPIO is ready to be uninstalled in a 
boot-from-SAN configuration.

PowerPath has prepared the system 
for uninstallation. You must 
restart your system and continue 
with PowerPath uninstallation.

1. Go to Control Panel and select 
Add/Remove Programs.

2. Select PowerPath from the list of 
programs.

3. Click Remove.

4. Reboot the host.

5. Repeat steps 1 through 3.

6. Reboot the host.
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Overview
The PowerPath Administrator graphical user interface for Windows Server consists of two 
applications:

◆ PowerPath Monitor — Continuously monitors your PowerPath configuration and alerts 
you of status changes. The "PowerPath Monitor" section provides additional 
information.

◆ PowerPath Administrator — Configures, monitors, and manages PowerPath devices. 
The "PowerPath Administrator" on page 56 provides additional information.

PowerPath Monitor
PowerPath Monitor (on the taskbar of your Windows desktop) continuously monitors the 
status of your PowerPath configuration. PowerPath Monitor can be set to alert you with 
visual and audible cues when the status changes.

For example, if a path fails, the icon changes accordingly as seen in Table 7 on page 54. 
Depending on the Notification settings you choose on the Options tab of the EMC 
PowerPath Admin (root node) Properties dialog box (see PowerPath Administrator online 
help for Windows Server), PowerPath Monitor may: 

◆ Sound an alarm. 

◆ Restore the PowerPath Administrator main window. 

◆ Flash the taskbar icon. 

◆ Or any combination thereof.

Table 7 shows the taskbar icons and the status each represents.

Table 7  PowerPath Monitor taskbar icons

Taskbar 
Icon Status

Optimal — All configured paths are operating properly.

Degraded — Some but not all paths have failed.

All Failed — All configured paths have failed.

Server Not Responding — Cannot communicate with Monitor 
service. This occurs if the PowerPath Administrator Suite 
encountered errors during initialization.
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Note: All non-optimal monitor icons appear only if you have selected the Flash Taskbar 
Icon on the Options tab of the EMC PowerPath Admin (root node) Properties dialog box. 
The root node is the top-level view of your configuration and represents the host that is 
being managed by PowerPath.

Launching MMC with the PowerPath snap-in

You can use PowerPath Monitor to do the following:

◆ Launch Microsoft Management Console (MMC) with the PowerPath snap-in.

◆ Notify you of PowerPath status changes if you are running it on a local host.

Note: The EMC PowerPath Administrator Monitor monitors the local host only. It does not 
remotely monitor the status of another host. The icon is only present on the Windows 
taskbar on the host with EMC PowerPath Administrator installed. If you are running 
PowerPath for the first time on a remote host, you must start the application according to 
the instructions at "Local or remote administration" on page 60.

To launch the Microsoft Management Console (MMC) with the PowerPath Snap-in, do one 
of the following:

◆ Double-click the PowerPath Monitor icon on the Windows taskbar to launch the 
default MMC console with the PowerPath Snap-in.

or

◆ Right-click the PowerPath Monitor icon to display the following context menu options:

• PowerPath Administrator — Launches PowerPath Administrator.

• Close Monitor — Closes the EMC PowerPath Administrator Monitor.

PowerPath registration tools
You can use the PowerPath Licensing Tool or the emcpreg command to register PowerPath 
and related products.

PowerPath Licensing Tool

The Licensing Tool is used to register PowerPath and other products, from the Windows 
GUI. The Licensing Tool is displayed during PowerPath installation (except when the host 
is connected to a CLARiiON AX-series array). To manage licenses, you can launch the tool 
by selecting Start > All Programs > EMC > PowerPath Licensing Tool.

This tool allows you to add or remove licenses. For more information, see the online help 
(press F1) or launch the help file, EMCLicTool.chm, from the PowerPath software CD or the 
\help directory. 

Note: You must have Internet Explorer 5.1 or later to view the online help files. If you do 
not have this browser installed, you may still view the help file from the EMCLicTool.chm 
file.
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emcpreg command

The emcpreg command facilitates scripting options and is the only way to manage 
licenses with the Windows Server 2008 and later core versions. The emcpreg command is 
supported with all supported Windows platform versions.

To add a license with emcpreg command line, enter:

emcpreg -add <key>

where <key> is the product license key.

The PowerPath CLI and System Messages Reference on EMC Online Support provides 
additional information.

PowerPath Administrator
For Windows Server, the PowerPath Administrator runs as a snap-in program within 
Microsoft Management Console (MMC). You can use MMC and the PowerPath Snap-in to 
monitor a local or remote host. "Local or remote administration" on page 60 provides 
additional information.

The PowerPath Administrator is a graphical user interface for configuring, monitoring, and 
managing PowerPath devices. The PowerPath Administrator continuously monitors a 
multipath storage-system environment and automatically updates the configuration 
information that appears. 

You can use PowerPath Administrator to set up and change your device configuration and 
manage physical and logical path components. The PowerPath Administrator displays a 
hierarchical representation of paths, logical devices, and HBAs.

PowerPath Administrator displays the components of a PowerPath system as objects. 
PowerPath Administrator icons represent the PowerPath objects in your configuration. The 
type of icon reflects the state or status of the particular object selected. Table 8 on 
page 58 and Table 9 on page 59 display PowerPath Administrator icons.

PowerPath Administrator panes

As part of MMC, the PowerPath Administrator has two panes:

◆ The scope pane displays PowerPath objects in a hierarchical list that can be expanded 
or collapsed. 

◆ The result pane provides a view of configuration statistics for PowerPath objects 
selected in the scope pane.

PowerPath Administrator device properties dialog box

You can access most of the PowerPath Administrator functions through the tabs available 
in the device Properties dialog box. Right-click the EMC PowerPathAdmin root node and 
then select Properties. 

The PowerPath properties are as follows:

◆ PowerPath admin (root node) properties — Use this to:

• Show root node details. 
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• Set local or remote host options. 

• Set error notification options. 

• Set Auto-Restore. 

• View array management information. 

• Set the path latency options.

• Manage the autostandby feature options.

Note: The root node is the top-level view of your configuration and represents the host 
that is being managed by PowerPath. The Root Node Properties dialog box contains 
the Details, Computer, and Options tabs. (The Computer tab is present only when you 
are connected to a remote host). 

◆ Storage array properties — Use this to show storage array details. To display this tab, 
select a storage array, right-click, and select Properties.

◆ Storage array port properties — Use this to show storage array port details. To display 
this tab, select a storage array port, right-click, and select Properties.

◆ Adapter properties — Use this to show adapter details and change modes on the 
adapter. To display this tab, select an adapter, right-click, and select Properties.

◆ Disk properties — Use this to show disk details, change modes on the disk, and 
change load-balancing policies and priorities. To display this tab, select a disk, 
right-click, and select Properties.

◆ Path properties — Use this to show path details and change the mode of a path. To 
display this tab, select a path, right-click, and select Properties.

Note: The previous examples illustrate the most common PowerPath Administrator 
functions. The PowerPath Administrator online help for Windows Server provides 
complete information on using all the PowerPath Administrator functions. 

If you do not have Internet Explorer 5.1 or later installed on your system, you will be 
unable to launch the PowerPath online help files for Windows Server from the MMC 
console. If you want to view the help file without installing Internet Explorer, you can 
launch the EmcPowerPathAdminMMC.chm file directly from the \help folder on the 
PowerPath installation CD.
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Icons: standard, unlicensed, and unknown conditions

Table 8 shows icons for standard, unlicensed, unknown, and mismatched states. 
Standard icons represent a configuration in which PowerPath is optimal.

Note: The online help provides more information on icons and their meaning.

Icons: known failure conditions

When a path fails, the failure propagates through other PowerPath Administrator objects. 
These objects are displayed in a hierarchy in the scope pane and result pane. These 
known failure icons represent configurations that are less than optimal.

Table 9 on page 59 shows known failure icons. Icons for:

◆ Degraded conditions.

◆ Failed conditions.

◆ Unlicensed and degraded conditions.

◆ Unlicensed and failed conditions.

Degraded PowerPath objects are represented by a red slash through the standard object 
icon. (Because a path is either open or closed, the path icon is never shown as degraded.) 
Failed PowerPath objects are represented by a red X through the standard object icon.

Table 8  Icons on the PowerPath Administrator

Object Standard Icon Unlicensed Icon Unknown Icon
Mismatched 
Icon

Root Node — Graphical representation of the host and 
top level view of your configuration. N/A

Storage Array — An attached storage system that 
provides logical devices which are managed by 
PowerPath.

N/A

Storage Array Port — Identifies a port within a specific 
storage array that provides I/O paths to the logical 
devices.

N/A

Disk — A logical device managed by PowerPath. Logical 
devices are disk devices presented by the storage 
system.

N/A

Adapter — A device that provides an interface between 
the SCSI or Fibre Channel bus and the computer I/O 
bus. An adapter can have multiple paths associated 
with it.

N/A

Path — The logical or physical I/O path from the host to 
the storage system, including the HBA, cable, and 
interface port.
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The definition of degraded and failed status depends on the context shown in Table 9 on 
page 59. For example, an unlicensed version of PowerPath with degraded or failed paths 
displays icons that combine elements of both the unlicensed and degraded icons.

Unless specified otherwise, all icons display in both the summary and details panes.

Table 9  Icons of known PowerPath failure conditions

Object Degraded Icon Failed Icon
Unlicensed and Degraded 
Icon

Unlicensed and Failed 
Icon

Root Node EMC PowerPath 
Administrator is 
identifying a 

degradation within the 
managed environment.

EMC PowerPath 
Administrator is in 
a failed state.

EMC PowerPath is 
unlicensed and 
identifying a 

degradation within the 
managed environment.

EMC PowerPath 
Administrator is 
unlicensed and in 

a failed state.

Storage 
Array

One or more (but 
not all) paths to 
the storage array 
have failed or are 
in a degraded 

state.

All paths to the 
specific array have 
failed. This array is 
not available.

EMC PowerPath 
Administrator is 
unlicensed. One 
or more (but not 

all) paths to the array 
have failed or are in a 
degraded state.

EMC PowerPath 
Administrator is 
unlicensed. All 
paths to the 

specific array have failed. 
This array is not available.

Storage 
Array Port

One or more (but 
not all) paths to 
the storage array 
port have failed or 

are in a degraded state.

All paths to the 
specific array port 
have failed. This 

array port is not available.

EMC PowerPath 
Administrator is 
unlicensed. One 
or more (but not 

all) paths to the array port 
have failed or are in a 
degraded state.

EMC PowerPath 
Administrator is 
unlicensed. All 

paths to the specific array 
port have failed. This array 
port is not available.

PowerPath 
device 

One or more (but 
not all) paths to 
the disk device 

have failed.

All paths to the 
specific disk 
device have 

failed. This disk is not 
available.

EMC PowerPath 
Administrator is 
unlicensed. One 

or more (but not all) paths 
to the disk device have 
failed.

EMC PowerPath 
Administrator is 
unlicensed. All 

paths to the specific disk 
device have failed. This 
disk is not available.

Adapter One or more (but 
not all) adapters 
have either failed 

or degraded. Displays in 
the Adapters folder in the 
scope pane. 

One or more (but not all) 
paths have failed on the 
specific adapter.

All paths on this 
adapter have 
failed.

EMC PowerPath 
Administrator is 
unlicensed. One 

or more (but not all) paths 
have failed on the specific 
adapter.

EMC PowerPath 
Administrator is 
unlicensed. All 

paths on this adapter 
have failed.

Path Not applicable. One or more of 
the hardware 
components 
that make up the 

path has failed; therefore, 
the entire path failed.

Not applicable. EMC PowerPath 
Administrator is 
unlicensed, and 

one or more of the 
hardware components 
that comprise the path 
has failed; therefore, the 
entire path fails.
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Undefined SP conditions

The following icons represent a rare condition on active/passive arrays, including VNX OE 
and CLARiiON, that produce a double link control card (LCC) failure. If you see these icons, 
the LCC fault light on the VNX OE or CLARiiON array should be amber. Refer to the VNX OE 
or CLARiiON documentation for troubleshooting information, or contact EMC Customer 
Support for information on replacing an LCC.

Table 10 on page 60 shows icons and descriptions specific to CLARiiON arrays.

Local or remote administration
With MMC and the PowerPath Snap-in, you can monitor a local host or a remote host.

◆ Local administration — EMC PowerPath Administrator is installed on the local host by 
default. The installation process provides a preconfigured .msc file to launch the 
Microsoft Management Console (MMC). Once PowerPath is installed, you can use 
PowerPath to monitor the local host immediately. 

To launch MMC with the PowerPath Snap-in:

Select Start > All Programs > EMC > PowerPath > PowerPathAdmin.

Note: The path starts the PowerPath Snap-in and the MMC console on the local host 
with no other action required. However, there may be scenarios in which you need to 
add the PowerPath Snap-in to a new MMC console. For example, you may want to 
create another instance of PowerPath Administrator on the local host or you may have 
deleted the PowerPath Snap-in and want to add it again. "Setting a local host option" 
on page 61 provides additional information on how to add the PowerPath Snap-in to 
the MMC console to monitor a local host.

◆ Remote administration — If you want to monitor a remote host that has PowerPath for 
Windows Server 2003 installed, you may supply the credentials for remote access to 
that host. "Setting a remote host option" on page 61 provides additional information 
on how to add the PowerPath Snap-in to monitor a remote host with PowerPath 
installed.

Table 10  Icons of undefined SP PowerPath failure conditions

Standard Icon Degraded Icon Failed Icon Unlicensed Icon
Unlicensed and 
Degraded Icon

Unlicensed and 
Failed Icon

The 
CLARiiON 
link control 

cards (LCC) have 
failed. The SP 
owning the disk is 
unknown and the 
disk is 
unavailable.

The 
CLARiiON 
link control 

cards (LCC) have 
failed. The SP 
owning the disk is 
unknown and one 
or more (but not 
all) paths to the 
disk device has 
failed. The disk is 
unavailable.

The 
CLARiiON 
link control 

cards (LCC) have 
failed. The SP 
owning the disk is 
unknown and all 
paths to the disk 
device has failed. 
The disk is 
unavailable.

The 
PowerPath 
Administra

tor is unlicensed 
and the CLARiiON 
link control cards 
(LCC) have failed. 
The SP owning the 
disk is unknown 
and the disk is 
unavailable.

The 
PowerPath 
Administra

tor is unlicensed 
and the CLARiiON 
link control cards 
(LCC) have failed. 
The SP owning the 
disk is unknown 
and one or more 
(but not all) paths 
to the disk device 
has failed. The 
disk is 
unavailable.

The 
PowerPath 
Administra

tor is unlicensed 
and the CLARiiON 
link control cards 
(LCC) have failed. 
The SP owning the 
disk is unknown 
and all paths to 
the disk device 
has failed. The 
disk is 
unavailable.
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Note: When PowerPath 3.0.5 or later is installed for Windows Server 2003 on more 
than one host, you can use the Remote Host Option to monitor any host from any other 
host. 

Setting a local host option

Adding the PowerPath Snap-in to MMC and monitoring a local host is a two-part 
procedure.

Part 1: Opening the MMC
1. Click Start

◆ If you are using Windows Server 2003, from the Start menu select Run.

◆ If you are using Windows Server 2008 or later, from the Start menu:

• in the Start Search text box, type mmc.

• in the Start Search text box, type cmd and then type mmc.

2. In the Open field, run mmc (32-bit OS versions) or mmc/32 (64-bit OS versions).

3. Click OK.

An MMC Console appears. The MMC title bar displays Console1. Within this pane is 
the Console Root. Initially this folder is empty. However, once the snap-in is added, 
this folder will contain the EMC PowerPath Administrator (and any other added 
snap-ins) and is displayed as expandable icons under the Console Root folder.

Part 2: Adding the EMC PowerPath Administrator snap-in
1. From the MMC console, select File > Add/Remove Snap-in.

2. Select  PowerPath Administration and click Add.

3. Select Local Computer.

4. Click Finish.

5. In the Add Standalone Snap-in dialog box, click Add to add another snap-in or click 
Close.

6. In the Add/Remove Snap-in dialog, click OK. 

EMC PowerPath Administrator is now added to the MMC console.

You can now use EMC PowerPath Administrator to configure, manage, and monitor 
PowerPath devices.

Once you have changed your configuration, save the configuration. "Saving a 
configuration" on page 63 provides additional information.

Setting a remote host option

Adding the PowerPath snap-in to MMC and monitoring a remote host that has PowerPath 
3.0.5 or higher for Windows Server 2003 installed is a two-part procedure.
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Part 1: Opening the MMC
To open the MMC:

1. Click Start

◆ If you are using Windows Server 2003, from the Start menu select Run.

◆ If you are using Windows Server 2008 or later, from the Start menu:

• in the Start Search text box, type mmc.

• in the Start Search text box, type cmd and then type mmc.

2. In the Open field,  run mmc (32-bit OS versions) or mmc/32 (64-bit OS versions).

3. Click OK.

An MMC Console appears. The MMC title bar displays Console1. Within this pane is 
the Console Root. Initially this folder is empty. However, once the snap-in is added, 
this folder will contain the EMC PowerPath Administrator (and other snap-ins you may 
add) and is displayed as expandable icons under the Console Root folder. 

Part 2: Adding the EMC PowerPath Administrator snap-in
1. From the MMC console, select File > Add/Remove Snap-in. 

2. Select  PowerPath Administration and click Add.

3. Select Another Computer.

4. Type the computer name or browse for the remote computer.

5. In the Browse for Computer dialog box, click OK.

6. Type your User Name, Domain Name, and Password.

7. Click Finish.

Note: The User Name, Domain Name, and Password fields are subsequently available 
for editing from the root node Properties page if you are using MMC to monitor a 
remote host. The section "Set Remote Host Options" in the PowerPath Administrator 
online help provides additional information.

8. In the Add Standalone Snap-in window, click Add to add another snap-in or click 
Close.

9. In the Add/Remove Snap-in window, click OK. EMC PowerPath Administrator is now 
added to the MMC console.

Saving and loading Administrator settings
You can use EMC PowerPath Administrator to configure, manage, and monitor PowerPath 
devices. The first time you run EMC PowerPath Administrator, there is a default 
configuration. If you make changes, you can save them to a configuration file. The file 
records the serial numbers, mode, policy, and priority for each configured path. You can 
also load the last known configuration or a previously saved file.
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Note: PowerPath configuration files are distinct from the Microsoft Management Console 
(MMC) configuration files. If you close the MMC window, MMC prompts you to save the 
MMC settings. These settings are not the same as the EMC PowerPath Administrator 
settings. Saving the MMC console settings does not save your PowerPath configuration 
changes. These changes will be lost unless you complete the following procedure.

Saving a configuration

To save the current PowerPath Administrator settings:

Note: Saving the configuration may override an existing configuration file. Provide a 
unique file name and use the Save As option to avoid overriding an existing configuration 
file.

◆ Enter powermt save [file=<pathname>]

or

◆ In PowerPath Administrator, right-click the root node and select All Tasks > Save Config 
as. Specify a file name and click Save.

Loading a configuration

You can load the last known reboot state or a previously saved EMC configuration file. 

To load a configuration: 

1. In the scope pane, select the EMC PowerPath Admin root node.

2. To load a previously saved PowerPath configuration, right-click the root node and 
select All Tasks > Load Config File.

To load the last known reboot state, right-click the root node and select All Tasks > 
Load Reboot Config.

Saving MMC console settings
The MMC console enables you to display the PowerPath Snap-in data in many ways. If you 
change your MMC console configuration (for example, if you resize columns, change 
column displays, or change column sort order), you may want to save these new MMC 
console settings. 

If you close the MMC console itself, or the PowerPath Snap-in within the MMC console, 
MMC prompts you with the following message: 

Save console settings to <filename>.msc? 

Click Yes to save the latest console settings. By default, the MMC console settings are 
saved as console1.msc in the folder:

%SystemDrive%\Programs\Administrative Tools 

You can save the console settings anytime with the Console, Save menu option in the 
MMC console. 
Saving MMC console settings 63



Managing PowerPath
To save the file with a different name or to a different location, go to MMC Console > Save 
As.

PowerPath and Systems Management Server (SMS)
PowerPath has been qualified with the Systems Management Server (SMS) software from 
Microsoft, which allows remote management of large groups of Windows-based systems. 
SMS allows you to remotely manage patches, distribute software, deploy operating 
systems, and perform software and hardware inventories. 

The high level steps for deploying PowerPath using SMS are:

1. Create a PowerPath package in SMS.

2. Create a program for that PowerPath package.

3. Assign distribution points to that package.

4. Advertise the package to target clients by defining a collection.

See the Microsoft SMS product documentation for detailed instructions.

Traybar and UAC modifications
Beginning with  Windows Server 2008, Microsoft introduced modifications to the traybar 
monitor program and the User Account Control (UAC):

◆ The traybar monitor program now communicates to the PowerPath service where it 
previously communicated directly with the kernel driver. This means that if the 
PowerPath service is disabled or fails to start, the traybar monitor will not function and 
an error displays. 

◆ For those tasks that require administrator privileges, you receive the elevated prompt 
when:

• Opening the GUI from the traybar monitor.

• Launching admin GUI from a program group.

• Starting the license tool.

When the license tool is launched from the Installation program, you do not receive an 
elevation prompt.

Note: The above information is valid only for built in administrator accounts and any 
accounts which are part of the administrator group, if UAC is turned on.

Audit and error log messages
The EMC PowerPath Family CLI and System Messages Reference on EMC Online Support 
describes audit logging, including instructions for setting up logging in your environment. 
It also lists error messages, descriptions, and suggested corrective action.
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Installing PowerPath and MSCS
If you are installing PowerPath and MSCS for the first time, install PowerPath first, and 
then install MSCS. Installing PowerPath first avoids disruption of cluster services at a later 
time. The Microsoft MSCS documentation provides complete information on planning, 
configuring, managing, and troubleshooting MSCS.

After installing PowerPath and MSCS, run the emcphostid check command to check for 
host conflicts. If the host IDs are not unique, run the emcphostid set command to set a 
unique host ID.

Integrating PowerPath into an existing MSCS cluster
You can integrate PowerPath into an existing MSCS cluster, without shutting down the 
cluster, if there is close coordination between the nodes and the storage system.

Each node in a cluster can own a distinct set of resources. Node A is the primary node for 
its resources and the failover node for node B resources. Conversely, node B is the primary 
node for its resources and the failover node for node A resources.

The Microsoft MSCS documentation provides complete information on planning, 
configuring, managing, and troubleshooting MSCS.

Note: After installing PowerPath on the cluster, any testing involving node failover by 
disconnecting all cables for a LUN or otherwise disrupting the path between the active 
host and the array logs an event message in Windows. These event messages will indicate 
hardware or network failure and possible data loss. If working correctly, the cluster will 
failover to a node with an active path and you can ignore the messages from the original 
node as logged in the event log. 
You should check the application generating I/O to see if there are any failures. If there are 
none, everything is working normally.

The following procedure describes how to install PowerPath on a two-node cluster. You 
can also install PowerPath on clusters with more than two nodes. In these cases, the 
appropriate action is noted where applicable for clusters with more than two nodes.

To add PowerPath to an existing MSCS cluster (with MSCS running on both nodes), follow 
these procedures:

◆ "Moving all resources to node A" on page 67

◆ "Installing PowerPath on node B" on page 67

◆ "Configuring additional paths between the storage system and node B" on page 67

◆ "Moving all resources to node B" on page 67

◆ "Installing PowerPath on node A" on page 67

◆ "Configuring additional paths between the storage system and node A" on page 68

◆ "Returning node A resources to node A" on page 68

◆ "Checking for host ID uniqueness" on page 68
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Moving all resources to node A

1. Start the MSCS Cluster Administrator utility (Windows Server 2003) or the Windows 
Server Failover Cluster Manager Console (Windows Server 2008 and later).

2. Select all groups owned by node B.

3. Move the resources to node A.

4. Pause node B. This keeps the node from participating in the cluster during PowerPath 
installation.

Installing PowerPath on node B

1. Install PowerPath on node B.

2. Shut down node B.

In a cluster with more than two nodes, install PowerPath on these other nodes (steps 1 
and 2). For example, in a four-node cluster, replace node B with nodes B, C, and D as 
shown in step 4 in the section "Moving all resources to node A" on page 67.

Configuring additional paths between the storage system and node B

1. If necessary, reconfigure the storage system so its logical devices appear on multiple 
ports.

2. If necessary, install additional HBAs on node B.

3. Connect cables for new paths between node B and the storage system.

4. Power on node B.

5. To resume node B, click on node B and do the following:

a. On Windows Server 2003 select File > Resume Node.

b. On Windows Server 2008 and later, right-click > Resume.

In a cluster with more than two nodes, configure additional paths between the storage 
system and these other nodes. In a four-node cluster, replace node B with nodes B, C, and 
D in steps 2, 3, 4, and 5 above.

Moving all resources to node B

1. In the left pane of the Cluster Administrator window, select all groups.

2. Move the resources to node B.

In a cluster with more than two nodes, move all resources to any of the remaining 
nodes. For example, in a four-node cluster, replace node B with any combination of 
nodes B, C, and D to which you want to move resources. 

3. Pause node A.

Installing PowerPath on node A

1. Install PowerPath on node A.
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2. Shut down node A.

Configuring additional paths between the storage system and node A

1. If necessary, configure the storage system so its logical devices appear on multiple 
ports.

2. If necessary, install additional HBAs on node A.

3. Connect cables for new paths between node A and the storage system.

4. Power on node A.

5. Resume node A.

Returning node A resources to node A

1. Using the MSCS Cluster Administrator utility (Windows Server 2003) or the Windows 
Server Failover Cluster Manager (Windows Server 2008 and later), select all groups 
previously owned by node A.

2. Move the resources back to node A.

Checking for host ID uniqueness

Run the emcphostid check command to check for host uniqueness. If the host IDs are not 
unique, run the emcphostid set command to set unique host IDs.
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Installing PowerPath and VCS
If you are installing PowerPath and VCS for the first time, install PowerPath first, and then 
install VCS. Installing PowerPath first avoids disruption to the cluster services at a later 
time. The Veritas Storage Foundation High Availability (SFHA) documentation provides 
complete information on planning, configuring, managing, and troubleshooting VCS.

After installing PowerPath and VCS, run the emcphostid check command to check for host 
conflicts. If the host IDs are not unique, run the emcphostid set command to set a unique 
host ID.

Installing PowerPath in an existing VCS environment

Ensure that you follow these steps to manage your cluster environment. Failure to do so 
can result in data corruption and data loss. Refer to the VCS documentation on how to 
configure and manage VCS in a clustered environment.

To install PowerPath in an existing VCS:

1. In the Cluster Administrator window, ensure all resources are on the primary node in 
the cluster. When the cluster resources are on the primary node, the ClusterService in 
the Status View dialog box appears as online.

Note: The procedure for setting up VCS on Windows Server 2008 may differ from 
Windows Server 2003. The Veritas documentation provides additional information. 
The procedure for installing PowerPath on VCS follows the same steps as mentioned 
for VCS on Windows Server 2003.

2. From the navigation pane on the left, right-click ClusterService and select Disable. This 
disables the secondary node in the VCS configuration.

3. Install PowerPath on the secondary node. Follow the procedures in “Installation 
procedures” on page 19.

4. After installation and reboot of the secondary node, right-click ClusterService and 
select Enable to re-enable the node in the VCS configuration.

5. Right-click ClusterService, select Switch to, and then select the secondary node to 
move all cluster resources over to the secondary node.

6. Run vxdisk list. You will see the devices are in the BasicGroup and RAW group.

The vxdisk list command will display the proper DiskType and DiskGroup information.

7. Once the resources are available on the secondary node:

a. Run vxassist rescan.

b. Run vxdisk list to verify the disks are now in the proper disk group and show MBR.

If there are additional nodes in the cluster configuration, repeat steps 2 through 7 for 
each node.
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8. Run the emcphostid check command to check for host uniqueness. If the host IDs are 
not unique, run the emcphostid set command to set unique host IDs.

DiskType and DiskGroup information
The vxdisk list command displays DiskType as RAW instead of MBR and all disks appear to 
be in the default DiskGroup ‘BasicGroup’ after the installation of PowerPath.

C:\Documents and Settings\Administrator>vxdisk list
Name     MediaName Diskgroup  DiskStyle Size(MB) FreeSpace(MB) Status EnclosureID     P#C#T#L#
Harddisk0          BasicGroup MBR     156327    127327     Uninitialized DISKS@lhclu056 P0C0T0L0
Harddisk1   Disk1   dg1       RAW     10236     0          Imported      DGC0           P2C0T0L0
Harddisk2   Disk2   dg1       RAW     10236     0          Imported      DGC0           P2C0T1L1
Harddisk3   Disk3   dg1       RAW     10236     5118       Imported      DGC0           P2C0T0L2
Harddisk4   Disk4   dg1       RAW     10236     5118       Imported      DGC0           P2C0T1L3
 
C:\Documents and Settings\Administrator>vxassist rescan
Successfully rescanned

Note: Notice disk now properly show diskstyle as MBR

C:\Documents and Settings\Administrator>vxdisk list
Name      MediaName  Diskgroup  DiskStyle Size(MB) FreeSpace(MB) Status EnclosureID   P#C#T#L#
Harddisk0            BasicGroup  MBR      156327   127327 Uninitialized DISKS@lhclu056 P0C0T0L0
Harddisk1   Disk1     dg1        MBR      10236    0          Imported      DGC0           P2C0T0L0
Harddisk2   Disk2    dg1         MBR      10236    0          Imported      DGC0           P2C0T1L1
Harddisk3   Disk3    dg1         MBR      10236    5118       Imported      DGC0           P2C0T0L2
Harddisk4   Disk4    dg1         MBR      10236    5118       Imported      DGC0           P2C0T1L3

1. Disable the primary node in the VCS configuration and install PowerPath as described 
in “Installation procedures” on page 19.

2. After installing PowerPath, reboot the primary node.

3. Re-enable the node in the VCS configuration.

4. Move all cluster resources over to the primary node. Once the resources are available, 
run vxassist rescan.
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WHQL Certification
WHQL-certified driver
On Windows Server, the EMC PowerPath driver is WHQL-certified. To view the PowerPath 
driver signature:

1. Select Start > Control Panel > System.

2. Click Device Manager.

3. Expand the Storage controllers node. 

4. Right-click EMS device bus and then select Properties.

5. Click Driver > Driver Details to see the driver signature information.

When the driver is signed, the field contains information about the organization that 
assigned the driver.
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Files created by PowerPath installation
The following files are added when PowerPath is installed on 32-bit and 64-bit hosts. 
These file locations can change if you do not install to the default locations during 
PowerPath installation. Hence <Install directory> is denoted as a variable in the following 
sections.

Note: All driver files (.sys, .cat, and .inf) are copied to the internal system directories by the 
operating system when they are installed.

<Install directory>\PowerPath
◆ ckmadm.exe
◆ db_recover.ese
◆ db_recover.exe.manifest
◆ DIFxAPI.dll
◆ EMC_PowerPath_Console.msc
◆ EmcAdminProxy.dll
◆ EmcAdminSvr.exe
◆ emcp_mp_rtl.dll
◆ emcp_mpio_win.dll
◆ emcp_xcryptd.exe
◆ emcphostid.exe
◆ EmcpLogMsgs.dll
◆ EmcpMgmtComp.exe
◆ EmcpPerfmonPmiPrvdr.dll
◆ EmcPowerPathAdmin.dll
◆ EmcPowPN22.dll
◆ emcpreg.exe
◆ Install.exe
◆ libdb51.dll
◆ libdb51.dll.manifest
◆ libxml2.dll
◆ ManagementComp_Config.exe
◆ powerpath.man
◆ powermig.exe
◆ powermigcl.exe
◆ powermt.exe
◆ powervt.exe
◆ PowMigSrvc.exe
◆ ppinstall.exe
◆ ppme.dll
◆ pthreadVC2.dll
◆ RKM_Config.exe
◆ RKM_Config_CHS.dll
◆ RKM_Config_DEU.dll
◆ RKM_Config_ESP.dll
◆ RKM_Config_FRA.dll
◆ RKM_Config_ITA.dll
◆ RKM_Config_JPN.dll
◆ RKM_Config_KOR.dll
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◆ RKM_Config_PTB.dll
◆ rkmc_cache_conv.exe
◆ EmcLicTool.exe
◆ EmcLicTool_CHS.dll
◆ EmcLicTool_DEU.dll
◆ EmcLicTool_ESP.dll
◆ EmcLicTool_FRA.dll
◆ EmcLicTool_ITA.dll
◆ EmcLicTool_JPN.dll
◆ EmcLicTool_KOR.dll
◆ EmcLicTool_PTB.dll
◆ emcp_lic_rtl.dll
◆ emcp_mpapi_rtl.dll
◆ EmcPowMon.exe
◆ EmcPowRes.dll
◆ EmcPowSrv.exe
◆ EmcpSvcErr.dll
◆ libeay32.dll
◆ server.pem
◆ ssleay32.dll

<Install directory>\PowerPath\X86 (X64 and IA64 hosts only)
◆ emcp_lic_rtl.dll
◆ emcp_mp_rtl.dll
◆ EmcPowPN22.dll
◆ pthreadVC2.dll

<Install directory>\EMC\PowerPath\Drivers 
◆ EmcpBase.cat
◆ Emcpbase.inf
◆ EmcpBase.sys
◆ EmcpClass.cat
◆ EmcpClass.inf
◆ EmcpClass.sys
◆ EmcpCoinst30.dll
◆ emcpdm.cat
◆ emcpdm.inf
◆ EmcpDm.sys
◆ emcpgpx.cat
◆ emcpgpx.inf
◆ EmcpGpx.sys
◆ EmcpMd.cat
◆ EmcpMd.inf
◆ EmcpMd.sys
◆ EmcpMpx.cat
◆ EmcpMpx.inf
◆ EmcpMpx.sys
◆ EmcpXcr.cat
◆ EmcpXcr.inf
◆ EmcpXcr.sys
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◆ LamClar.cat
◆ LamClar.inf
◆ LamClar.sys
◆ LamEss.cat
◆ LamEss.inf
◆ LamEss.sys
◆ LamGen.cat
◆ LamGen.inf
◆ LamGen.sys
◆ Lamhit.cat
◆ Lamhit.inf
◆ Lamhit.sys
◆ Lamhpxp.cat
◆ Lamhpxp.inf
◆ Lamhpxp.sys
◆ Lamhpsx.cat
◆ Lamhpsx.inf
◆ Lamhpsx.sys
◆ LamInv.cat
◆ Laminv.inf
◆ Laminv.sys
◆ LamSymm.cat
◆ LamSymm.inf
◆ LamSymm.sys
◆ Lamnet.sys
◆ Lamnet.inf
◆ Lamnet.cat
◆ Lamxtremio.sys
◆ Lamxtremio.inf
◆ Lamxtremio.cat
◆ RSA_CK.cat
◆ RSA_CK.inf
◆ RSA_CK.sys

<Install directory>\EMC\PowerPath\32bit\RSA\CST\lib (IA64 hosts)
◆ aceclnt.dll
◆ ccme_base.dll
◆ ccme_ecc.dll
◆ ccme_eccaccel.dll
◆ ccme_eccnistaccel.dll
◆ cryptocme2.dll
◆ cryptocme2.sig
◆ CSP.dll
◆ CSP-AuthenticationService.dll
◆ CSP-C.dll
◆ CSP-CatalogPosix.dll
◆ CSP-CatalogService.dll
◆ CSP-CatalogWindows.dll
◆ CSP-CertService.dll
◆ CSP-Configuration.dll
◆ CSP-DestinationAlert.dll
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◆ CSP-DestinationEventLog.dll
◆ CSP-DestinationFile.dll
◆ CSP-DestinationODBC.dll
◆ CSP-DestinationSyslog.dll
◆ CSP-EventSource.dll
◆ CSPI.dll
◆ CSPJNIWrappers.dll
◆ CSP-LayoutFlat.dll
◆ CSP-LayoutRaw.dll
◆ CSP-LayoutXML.dll
◆ CSP-lb.dll
◆ CSP-LDAP.dll
◆ CSP-LDAPClient.dll
◆ CSP-LocalDirectory.dll
◆ CSP-LocalizationService.dll
◆ CSP-LogService.dll
◆ CSP-MessageCatalog.dll
◆ CSP-OSLogin.dll
◆ CSP-PositionalFormatter.dll
◆ CSP-RoleManagement.dll
◆ CSP-RT.dll
◆ CSP-SecurID.dll
◆ CSP-Security.dll
◆ CSP-SM.dll
◆ CSP-SprintfFormatter.dll
◆ CSP-TrustedUser.dll
◆ CSP-UserManagement.dll
◆ CSP-XML.dll
◆ CST-admin.dll
◆ cstadmin.exe
◆ expat.dll
◆ LBJNIWrappers.dll
◆ osysrt.dll
◆ osysrtxml.dll
◆ RKM_Config.bat
◆ sdmsg.dll

<Install directory>\EMC\RSA\CST\xml
◆ Config.xml
◆ Config-Template.xml
◆ CSP.xml
◆ CSP-Admin.xml
◆ csp-app.xml
◆ CSP-Authn.xml
◆ CSP-CatalogPosix.xml
◆ CSP-CatalogService.xml
◆ CSP-CatalogWindows.xml
◆ CSP-CertificateManagement.xml
◆ CSP-Config.xml
◆ CSP-DestinationAlert.xml
◆ CSP-DestinationEventLog.xml
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◆ CSP-DestinationFile.xml
◆ CSP-DestinationODBC.xml
◆ CSP-DestinationSyslog.xml
◆ CSP-LayoutFlat.xml
◆ CSP-LayoutRaw.xml
◆ CSP-LayoutXML.xml
◆ CSP-LDAP.xml
◆ CSP-LocalDirectory.xml
◆ CSP-LocalizationService.xml
◆ CSP-Logging.xml
◆ CSP-OSLogin.xml
◆ CSP-PAM.xml
◆ CSP-PositionalFormatter.xml
◆ CSP-RoleManagement.xml
◆ CSP-saml-schema-assertion-1.1.xsd
◆ CSP-saml-schema-assertion-2.0.xsd
◆ CSP-SecurID.xml
◆ CSP-SM.xml
◆ CSP-SprintfFormatter.xml
◆ CSP-TrustedUser.xml
◆ CSP-UserManagement.xml
◆ CSP-xenc-schema.xsd
◆ xmldsig-core-schema.xsd

<Install directory>\EMC\RSA\Rkm_client\config
◆ rkm_init.conf.tmpl
◆ rkm_keyclass.conf.tmpl
◆ rkm_registration.conf.tmpl
◆ rkm_svc.conf.tmpl

<Install directory>\EMC\RSA\Rkm_Client\lib (32-bit)
◆ ccme_base.dll
◆ ccme_ecc.dll
◆ ccme_eccaccel.dll
◆ ccme_eccnistaccel.dll
◆ cryptocme2.dll
◆ cryptocme2.sig
◆ CSP-lb.dll
◆ CSP-Security.dll
◆ kmclient_shared.dll
◆ kmcryptolib.dll
◆ kmsvcshlib.dll

Note: On an IA 64 host, the above files will be copied under <Install 
directory>\EMC\PowerPath\32bit\RSA\Rkm_Client\lib (IA64 hosts).

Windows\Help
◆ EmcLicTool.chm
◆ EmcLicToolCHS.chm
◆ EmcLicToolDEU.chm
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◆ EmcLicToolESP.chm
◆ EmcLicToolFRA.chm
◆ EmcLicToolITA.chm
◆ EmcLicToolJPN.chm
◆ EmcLicToolKOR.chm
◆ EmcLicToolPTB.chm
◆ EmcPowerPathAdminMMC.chm

Windows\Cluster
◆ ppme.dll

%ALLUSERSPROFILE%\EMC\PowerPath
◆ bootstrapper_*.log
◆ msi_*.log
◆ ppinstall_*.log
◆ vcredist_<platform>_*.log
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